BOISE STATE UNIVERSITY GRADUATE COLLEGE STANDARDS AND GUIDELINES FOR THESES AND DISSERTATIONS

Boise State University

Graduate College

May 2013
ABSTRACT

The purpose of this document is to provide students and faculty with a clear understanding of the thesis/dissertation process and to provide clear standards and guidelines for formatting and creating a thesis/dissertation. Additionally, this document serves as an example of the formatting standards expected of students’ theses/dissertations.

Please see the current Boise State University Graduate Catalog (http://registrar.boisestate.edu/catalogs/graduate.shtml) for additional information regarding official Graduate College policies and regulations, as well as college, department, and program details.

If you have questions or concerns regarding the thesis/dissertation process or guidelines not addressed in this handbook or the Graduate Catalog, please contact Jodi Chilson, Coordinator of Theses and Dissertations, at 208-426-3604 or jodichilson@boisestate.edu.

The Thesis and Dissertation Office is located on the third floor of the Business building in room 307D.
TABLE OF CONTENTS

ABSTRACT........................................................................................................................................ iv

LIST OF TABLES .................................................................................................................................. x

LIST OF FIGURES .......................................................................................................................... xi

CHAPTER ONE: THESIS AND DISSERTATION PROCESS................................................................. 1

  New Changes ..................................................................................................................................... 1

  Thesis Process .............................................................................................................................. 2
    Overview .......................................................................................................................................... 2
    Detailed ........................................................................................................................................... 3

  Thesis: Required Forms and Instructions ......................................................................................... 9
    Forms Filled Out Prior to Defense .............................................................................................. 9
    Forms Filled Out During and/or Shortly After Defense ................................................................. 9
    Forms to Include with Your Review Copy of the Thesis ............................................................... 10
    Forms to Include with Your Final Copies Delivered to the Graduate College .......................... 10

  Dissertation Process ..................................................................................................................... 11
    Overview ......................................................................................................................................... 11
    Detailed ........................................................................................................................................... 12
    ProQuest ...................................................................................................................................... 19

  Dissertation: Required Forms and Instructions ............................................................................ 19
    Forms Filled Out Prior to Defense .............................................................................................. 19
Forms Filled Out During and/or Shortly After Defense ........................................ 20

Forms to Include with Your Review Copy of the Dissertation ...................... 20

Forms to Include with Your Final Copies Delivered to the Graduate College 21

ETD Process & ScholarWorks ........................................................................... 22

ScholarWorks .................................................................................................. 23

Keywords & Abstracts ....................................................................................... 23

General Deadlines: Thesis & Dissertation ................................................... 23

On-Campus Services for Students .................................................................. 27

The Writing Center ............................................................................................ 28

Albertsons Library ............................................................................................ 28

CHAPTER TWO: THESIS/DISSERTATION ELEMENTS, AND STANDARDS AND GUIDELINES................................................................. 30

Overview .......................................................................................................... 30

Types of Theses and Dissertations ................................................................. 31

General Standards and Guidelines for Traditional Theses and Dissertations .... 31

Order of Thesis/Dissertation Elements in Print Copy .................................. 31

Order of Thesis/Dissertation Elements in the Electronic Copy .................... 33

Article-Based Theses and Dissertation Guidelines .................................... 33

Abstract ........................................................................................................ 34

Introduction and Conclusion ......................................................................... 34

Chapter/Article Variation from Published Version .................................... 35

References ...................................................................................................... 35

For Articles Not Yet Published ..................................................................... 35

Thesis/Dissertation Elements ....................................................................... 36
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title Page</td>
<td>36</td>
</tr>
<tr>
<td>Copyright Page</td>
<td>40</td>
</tr>
<tr>
<td>Defense Committee Approval Page</td>
<td>42</td>
</tr>
<tr>
<td>Final Reading Approval Page</td>
<td>43</td>
</tr>
<tr>
<td>Acknowledgements</td>
<td>45</td>
</tr>
<tr>
<td>Autobiographical Sketch of the Author</td>
<td>45</td>
</tr>
<tr>
<td>Abstract</td>
<td>45</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>46</td>
</tr>
<tr>
<td>List of Tables &amp; List of Figures</td>
<td>46</td>
</tr>
<tr>
<td>References, Bibliography, or Works Cited</td>
<td>47</td>
</tr>
<tr>
<td>Appendix</td>
<td>47</td>
</tr>
<tr>
<td>Formatting Styles and Guidelines</td>
<td>48</td>
</tr>
<tr>
<td>General Formatting Guidelines</td>
<td>48</td>
</tr>
<tr>
<td>Block Quotes</td>
<td>52</td>
</tr>
<tr>
<td>Bullet Lists</td>
<td>53</td>
</tr>
<tr>
<td>Citations</td>
<td>53</td>
</tr>
<tr>
<td>Cross-References</td>
<td>53</td>
</tr>
<tr>
<td>Margins</td>
<td>54</td>
</tr>
<tr>
<td>Notes</td>
<td>54</td>
</tr>
<tr>
<td>Number Lists</td>
<td>55</td>
</tr>
<tr>
<td>Page Numbers</td>
<td>55</td>
</tr>
<tr>
<td>Paragraph</td>
<td>55</td>
</tr>
<tr>
<td>Figures</td>
<td>55</td>
</tr>
</tbody>
</table>
Figure Captions ........................................................................................................ 56
Figure Captions in Appendices ........................................................................... 56
Footnotes .................................................................................................................. 57
Tables ....................................................................................................................... 57
Table Captions ........................................................................................................ 58
Table Captions in Appendices ............................................................................... 58
Citation and Reference Standards and Guidelines .............................................. 59
Bibliography vs. References vs. Works Cited ....................................................... 59
Internal Citation ...................................................................................................... 60
Multimedia Files ..................................................................................................... 61

CHAPTER THREE: INSTRUCTIONS FOR USING THE GRADUATE TEMPLATE AND MICROSOFT WORD ................................................................. 62

Overview .................................................................................................................. 62
Writing Your Document within the Template ....................................................... 63
  Downloading the Template .................................................................................. 63
  Replacing Content and Applying Styles ............................................................. 63
  Formatting Landscape Pages .............................................................................. 64
  Replacing Table of Contents, List of Figures, and List of Tables ...................... 64
Attaching the Template to a Preexisting Document ............................................. 65
  Formatting Styles ............................................................................................... 65
  Attaching the Template ...................................................................................... 67
  Adjusting Margins ............................................................................................. 68
  Setting Page Numbers ....................................................................................... 68
  Inserting Table of Contents and Lists of Figures or Tables ............................ 70
Manually Formatting Your Document ............................................................. 71

Creating a Single File from Multiple Files Using Microsoft Word .......... 71

Setting Section Breaks in Microsoft Word .................................................. 71

Formatting Page Numbers in Microsoft Word ........................................... 72

Creating Dot Leaders for Manual Table of Contents in Microsoft Word ...... 74

Generating an Automatic Table of Contents Using Styles in Microsoft Word ............................................................................................................. 75

Creating Bookmarks for Your PDF Files in Microsoft Word ...................... 77

Creating a Single File from Multiple Files Using Acrobat Adobe Professional ............................................................................................................. 78

BIBLIOGRAPHY ........................................................................................................ 79

APPENDIX A ......................................................................................................... 80

Example Pages .................................................................................................... 80

APPENDIX B ......................................................................................................... 94

Common Mistakes Observed During Format Review and Editing Marks Used on Format Review ............................................................................................................. 94

APPENDIX C ......................................................................................................... 99

Final Copies Checklists for Theses and Dissertations ................................. 99

APPENDIX D ......................................................................................................... 103

Sample Permissions Letters ............................................................................ 103

INDEX ................................................................................................................ 107
## LIST OF TABLES

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table 1.1</td>
<td>May 2013 Graduation – Thesis &amp; Dissertation Process Deadlines</td>
<td>24</td>
</tr>
<tr>
<td>Table 1.2</td>
<td>August 2013 Graduation – Thesis &amp; Dissertation Process Deadlines</td>
<td>25</td>
</tr>
<tr>
<td>Table 1.3</td>
<td>December 2013 Graduation – Thesis &amp; Dissertation Process Deadlines</td>
<td>26</td>
</tr>
<tr>
<td>Table 2.1</td>
<td>Formatting Title Page Elements</td>
<td>36</td>
</tr>
<tr>
<td>Table 2.2</td>
<td>General Formatting Guidelines</td>
<td>48</td>
</tr>
<tr>
<td>Table 3.1</td>
<td>Word Styles and the Sections to Which They Should Be Applied</td>
<td>65</td>
</tr>
</tbody>
</table>
LIST OF FIGURES

Figure 1  This Is an Example Figure ................................................................. 56
CHAPTER ONE: THESIS AND DISSERTATION PROCESS

New Changes

Several significant changes have been made to the thesis and dissertation handbook:

- Chapter Two: Copyrights, Creative Commons, and Article-based works
  
  o We now provide information on applying a Creative Commons license to a thesis or dissertation. These licenses protect authors’ rights to ownership but provide greater freedom in sharing information.

  o Additionally, Chapter Two contains information on assembling an article-based thesis or dissertation. This section details the document components that must be included and the permissions that must be obtained when submitting this type of document.

- Chapter Three: The Thesis & Dissertation Office now offers students a template that follows all of our formatting requirements and allows students to automatically generate document components like landscape page numbers and the Table of Contents.

Please see the sections below for detailed information regarding these changes and other thesis/dissertation specific information. Also, please see the current Boise State University Graduate Catalog (http://registrar.boisestate.edu/catalogs/graduate.shtml) for
additional information regarding official Graduate College policies and regulations, as well as college, department, and program details.

**Thesis Process**

**Overview**

*Note:* Some of these items may be in a different order and may include other steps as determined by your department and advisor; this list is a general overview of the thesis process. Elements required by the Graduate College must occur in the order dictated below.

1. Determine topic.
2. Proposal (if required by department).
3. Select an advisor and committee.
4. Research & Write (an abstract is required).
5. Provide copies of the completed thesis to your committee at least 2 weeks prior to defense. (Consult your department for exact expectations regarding the time needed for review by the committee and advisor prior to the defense date.)
6. Defend the thesis. If passing, have Defense Committee Approval pages (3 copies on 25% cotton) signed. Bring signed originals to Graduate College.
7. Revise as per committee and advisor requests.
8. Submit a copy for your advisor to review; once approved, have Final Reading Approval pages (3 copies on 25% cotton) signed.
9. Print out a review copy of the thesis; bring review copy and the signed Final Reading Approval pages to the Graduate College.

10. After the Thesis Coordinator reviews the document, pick up review copy from the Graduate College and make required changes.

11. Submit 3 copies of the thesis, printed on 25% (white) cotton paper, and a rewritable CD with an electronic copy of the thesis to the Graduate College. Include a completed Access Agreement for Thesis and Dissertations.

Detailed

For any detailed information not provided below, please consult your advisor or contact the Graduate College. For additional information regarding required forms, see the “Thesis: Required Forms and Instructions” section. For additional information regarding thesis elements and formatting guidelines, see Chapter 2.

Proposal

A thesis proposal must be approved in advance by the supervisory committee. The thesis proposal presents the background, objectives, scope, methods, and time lines of the thesis research. The proposal requirements are not determined by the Graduate College but instead will be dictated by each specific department’s guidelines. Often, this proposal is part of an introductory research methods class; consult your advisor and/or department for details regarding the requirements of this proposal and whether a proposal is required as part of the thesis process.

Note: Substantive work done by the student prior to the appointment of the supervisory committee or work represented by credit other than 593 Thesis (such as 596 Independent Study and 696 Directed Research) is not
acceptable for the thesis under any conditions.

Committee Member Selection for the Thesis Committee

Make sure the committee members you want on your thesis committee are eligible. The members on your thesis committee must be on the graduate faculty approved by the Graduate Council. For a list of these professors, see the “Boise State University Graduate Faculty” and “Adjunct Graduate Faculty” sections of the current Boise State University Graduate Catalogue.

Abstract

An abstract is required. Because of the continued reliance on electronic media, the inclusion of an abstract is becoming increasingly important. As such, with the use of ScholarWorks and other such thesis/dissertation databases, an abstract becomes the only means of attracting readers to your research. See the “Abstract” section in Chapter 2 for information about writing the abstract for your thesis. See the “ETD Process and ScholarWorks” section in this chapter for information regarding how the electronic version of your thesis is processed and accessed in ScholarWorks.

Review Copy for Defense Committee

Each department has specific expectations regarding the amount of time the committees require to properly review a thesis before a defense. Consult with the department and your advisor to determine the timeframe for submitting a review copy to your committee and defending for the graduation timeline you desire.

Defense (Final Oral Examination) & Defense Committee Approval Page
Schedule your defense as soon as reasonable to ensure you are able to provide your committee enough time to review your work and to ensure you will be able to meet all deadlines from your department and the Graduate College. The final deadlines for defending your thesis and submitting the final copies of your thesis to the Graduate College are often within a couple of weeks of each other; plan accordingly.

Consult your advisor regarding the normal procedures and expectations for a Final Oral Examination. Bring at least three (3) copies of the Thesis Defense Committee Approval page, printed on 25% cotton paper, for the committee to sign once the final oral examination has been deemed satisfactory. You may bring these signed originals to the Graduate College as soon as the Final Oral Examination is complete for safe-keeping until you submit your final copies to the Graduate College.

If the Final Oral Examination is unsuccessful, see the “Failure of a Comprehensive Examination or Final Oral Examination” sub-section (pg. 34) of the “Regulations for Master’s Programs” section of the Boise State University 2012-2013 Graduate Catalog.

**Advisor Final Reading Approval**

Following the Final Oral Examination, the defense committee may suggest changes and revisions they would like incorporated into the thesis before the final copies are submitted to the Graduate College. Once the changes are incorporated, provide a copy of the revised thesis to the major advisor (or thesis chair); include at least three (3) copies of Thesis Final Reading Approval page, printed on 25% cotton paper, for the advisor to sign if the thesis is found to be satisfactory to the advisor.
Once the Thesis Final Reading Approval pages are signed, you may immediately deliver them to the Graduate College for safe-keeping or turn them in with the format review copy of your thesis.

**Thesis Format Review**

A Thesis Format Review must be completed before you can turn in final copies of the thesis to the Graduate College. Once you have defended your thesis successfully and have included all of the changes required by your committee, print out a copy of your completed and approved thesis, single-sided, on regular paper and deliver it to the Graduate College.

The Thesis Coordinator will review your thesis and notify you when it is ready to be picked up from the Graduate College. At that time, the Thesis Coordinator will provide you with a deadline for returning your final copies to the Graduate College.

No thesis will be accepted for review after the “Last day to submit final signed copies of dissertation or thesis to Graduate Dean’s office” deadline. A review copy of your thesis must be approved by the Thesis Coordinator before you are able to submit final copies to the Graduate College. Thus, if a thesis is not submitted for review before this deadline, the student will not graduate during the commencement for that semester.

During a Thesis Format Review, the Thesis Coordinator will ensure the accuracy of the Table of Contents, List of Figures, and List of Tables; in addition, the Thesis Coordinator verifies and cross-references the internal and external reference citations. The Thesis Coordinator will also verify the quality of the document submitted and will spend extra time verifying the detail and quality of the abstract.
Verify the quality of your document before submitting the document for review. The Thesis Coordinator is not a copy editor; rather, the Thesis Coordinator is a quality assurance specialist. If the thesis does not meet basic quality and thesis preparation guidelines, the document will be rejected. The document will then require further revision and modification by the student before it can be resubmitted for review by the Thesis Coordinator. Any document rejected from review might be in danger of not meeting the deadline for the desired graduation date.

Please allow 4-6 weeks for review of your document by the Coordinator of Theses and Dissertations.

Submission of Final Copies

Note: Only final copies that have been preceded by a format review will be accepted.

Note: The thesis or dissertation requirement of a graduate degree program is not considered satisfied until the Dean of the Graduate College approves its final version.

After incorporating all changes required by the Thesis Coordinator, print at least three (3) copies of the final version of the thesis on 25% cotton paper. Submit these hardcopies and one electronic copy (saved as a .doc, .docx, or .pdf file) on a rewriteable CD. Additional copies can be included, as per the “Personal Copies” section below.

With the final copies, also include a completed Access Agreement for Theses and Dissertations. See the “Thesis: Required Forms and Instructions” section below.

The final copies will undergo a further review by the Thesis Coordinator in order to verify all changes required during the format review were incorporated. If the desired changes were not incorporated, your final copies may need to be resubmitted with the
required changes. During this secondary review, the Thesis Coordinator also verifies all content and formatting to ensure nothing was missed during the review or printing.

Once the final hardcopies and electronic copy of the thesis are verified, the Thesis Coordinator will submit the thesis to the Dean of the Graduate College for Final Review and Approval. The thesis or dissertation requirement of a graduate degree program is not considered satisfied until the Dean of the Graduate College approves its final version.

Once the Dean of the Graduate College approves the thesis, he will sign the Thesis Final Reading Approval pages and return the documents to the Thesis Coordinator. The Thesis Coordinator will then finish processing the final copies.

**Personal Copies**

Three (3) official copies of the document are required by the Graduate College: 1) Library Archive Copy; 2) Library Circulation Copy; and 3) Department Copy. The required total binding fee for these official copies is $20.

*Note: Some departments do not require the additional Department Copy. These departments are Raptor Biology, Educational Technology, and Music. For students of these programs, only two official copies are required with a $10 binding fee.*

The Graduate College will now assist with binding personal copies of the thesis. For the regular $10 per copy fee, the Graduate College will facilitate binding of the following additional copies:

- Committee and Advisor Copies (3-5 copies)
- Personal Copy for the Student (1)
These copies must be printed by the student and delivered to the Thesis & Dissertation Office.

**Thesis: Required Forms and Instructions**

**Forms Filled Out Prior to Defense**

*Note: The Appointment of Supervisor Committee form should be submitted prior to the Application for Admissions to Candidacy form.*

- **Appointment of Supervisory Committee form**—Fill out and submit this form to Graduate Admissions (located in 307 on the third floor of the Business building) the second semester of the first year. This form is available here:
  
  [http://gradcoll.boisestate.edu/forms/](http://gradcoll.boisestate.edu/forms/)

- **Application for Admissions to Candidacy form**—Fill out and submit this form to Graduate Admissions (located in 307 on the third floor of the Business building) the second semester of the first year. See the Academic Calendar for the exact deadline date. This form is available here:
  
  [http://gradcoll.boisestate.edu/forms/](http://gradcoll.boisestate.edu/forms/)

**Forms Filled Out During and/or Shortly After Defense**

- **Thesis Defense Committee Approval page**—Print out at least three (3) copies of this page on 25% cotton paper and have your committee members sign them after you have successfully defended your thesis. Drop off the pages to the Thesis Coordinator’s office (Business Building, room 307D) as soon as the pages have been signed. The template for this form is available here:
  
  [http://gradcoll.boisestate.edu/forms/](http://gradcoll.boisestate.edu/forms/)
Forms to Include with Your Review Copy of the Thesis

- **Culminating Activity Review Request form**—The Graduate College will provide this form when you submit your thesis for review. This form provides the Thesis Coordinator with contact information and basic information regarding your thesis.

- **Thesis Final Reading Approval pages**—Print out at least three (3) copies of this page on 25% cotton paper and have your thesis advisor sign them after you’ve incorporated any changes the committee requested during defense. The thesis advisor’s signature ensures the final version of the thesis is satisfactory to the committee. The template for this form is available here:
  
  [http://gradcoll.boisestate.edu/forms/](http://gradcoll.boisestate.edu/forms/)

Forms to Include with Your Final Copies Delivered to the Graduate College

- **Electronic Thesis Approval page**—Include this page in the electronic version of your thesis, which will be submitted to the Graduate College on a rewriteable CD with the final hardcopies of your thesis. This page replaces the signed Thesis Defense Committee Approval page and Thesis Final Reading Approval page in the electronic copy of the thesis. An example of this page is available here:

  [http://gradcoll.boisestate.edu/forms/](http://gradcoll.boisestate.edu/forms/)

- **Submission of Culminating Activity and Binding Request**—Fill out and submit this page with the final copies of your thesis. This form will be provided by the Thesis Coordinator when your review copy of the thesis is returned to you. It provides additional contact and bindery information.
• **Graduate College Access Agreement for Thesis or Dissertation form**—Fill out and include this form with the final copies of your thesis when you deliver them to the Graduate College. This form provides you with the opportunity to dictate how you would like your electronic thesis accessed in ScholarWorks. It must be signed by both you and your advisor. If there are questions regarding this form and the completion of this form, please contact the Thesis Coordinator, Jodi Chilson, via e-mail (jodichilson@boisestate.edu) or phone (208-426-3604). This form is available here: [http://gradcoll.boisestate.edu/forms/](http://gradcoll.boisestate.edu/forms/)

**Dissertation Process**

**Overview**

*Note: Some of these items may be in a different order and may include other steps as determined by your department and advisor; this list is a general overview of the thesis process. Elements required by the Graduate College must occur in the order dictated below.*

1. Determine topic.

2. Proposal (if required by department).

3. Select an advisor and committee.

4. External Examiner is assigned, if requested.

5. Research & Write (an abstract is required).

6. Provide copies of the completed dissertation to your committee at least 2 weeks prior to defense. (Consult your department for exact expectations regarding the time needed for review by the committee and advisor prior to the defense date)

8. Revise as per committee and advisor requests.

9. Submit a copy for your advisor to review; once approved, have Final Reading Approval pages (3 copies on 25% cotton) signed.

10. Print out a review copy of the dissertation; bring the review copy and the signed Final Reading Approval pages to the Thesis & Dissertation Office.

11. After the Dissertation Coordinator reviews the document, pick up your review copy from the Thesis & Dissertation Office and make required changes.


**Detailed**

For any detailed information not provided below, please consult your advisor or contact the Graduate College. For additional information regarding required forms, see the “Dissertation: Required Forms and Instructions” section. For additional information regarding dissertation elements and formatting guidelines, see Chapter 2.
Proposal

A dissertation proposal must be approved in advance by the supervisory committee. The dissertation proposal presents the background, objectives, scope, methods, and time lines of the dissertation research. The proposal requirements are not determined by the Graduate College but will be dictated by each specific department guidelines. Often, this proposal is part of a research methods class; consult your advisor and/or department for details regarding the requirements of this proposal.

Note: Substantive work done by the student prior to the appointment of the supervisory committee or work represented by credit other than 693 Dissertation (such as 596 Independent Study and 696 Directed Research) is not acceptable for the dissertation under any conditions.

Committee Member Selection for the Dissertation Defense Committee

Make sure the committee members you want on your dissertation committee are eligible. The members on your defense committee must be on the graduate faculty approved by the Graduate Council. For a list of these professors, see the “Boise State University Graduate Faculty” section of the current Boise State University Graduate Catalogue.

External Examiner Is Assigned (If Requested)

An external examiner is appointed by the Dean of the Graduate College well in advance of the final oral examination by a process that begins when the chair of the supervisory committee submits a “Request for Appointment of an External Examiner for a Doctoral Dissertation” form to the Graduate College. The external examiner may be from the university or from outside the university but cannot be a member of the
academic unit that is responsible for the Ph.D. program. The role of the external examiner is to provide a perspective from outside the academic unit on the quality of the dissertation and the student’s ability to present and defend it.

**Abstract**

An abstract is required. Because of the continued reliance on electronic media, the inclusion of an abstract is becoming increasingly important. As such, with the use of ScholarWorks and other such thesis/dissertation databases, an abstract becomes the only means of attracting readers to your research. See the “Abstract” section in Chapter 2 for information about writing the abstract for your dissertation. See the “ETD Process and ScholarWorks” section in this chapter for information regarding how the electronic version of your dissertation is processed and accessed in ScholarWorks.

**Review Copy for Defense Committee**

Each department has specific expectations regarding the amount of time the committees require to properly review a dissertation before a defense. Consult with the department and your advisor to determine the timeframe for submitting a review copy to your committee and defending it for the graduation timeline you desire.

**Defense (Final Oral Examination) & Defense Committee Approval Page**

Schedule your defense as soon as reasonable to ensure you are able to provide your committee enough time to review your work and to ensure you will be able to meet all deadlines from your department and the Graduate College.

The final oral examination should occur no later than the date specified in the academic calendar; this date is set to allow time for final revision and processing of the
dissertation so that a student who passes the final oral examination has a reasonable chance for graduation in the same semester or session. The final deadlines for defending your dissertation and submitting the final copies of your dissertation to the Graduate College are often within a couple of weeks of each other; plan accordingly.

Consult your advisor regarding the normal procedures and expectations for a Final Oral Examination. The final oral examination for a Ph.D. student (also called a defense) must consist of three (3) sequential parts in which the student presents and defends the dissertation research: 1) a public presentation, 2) a public question and answer session, and 3) a private question and answer session with the defense committee.

The defense committee must include the entire supervisory committee plus a nonvoting graduate faculty representative (GFR) appointed by the Dean of the Graduate College. The GFR conducts all three parts of the final oral examination according to procedures established by the Graduate College. At the request of the advisor, an external examiner may also be present.

Bring at least three (3) copies of the Dissertation Defense Committee Approval page, printed on 25% cotton (watermarked) paper, for the committee to sign once the final oral examination has been deemed satisfactory. You may bring these signed originals to the Graduate College as soon as the Final Oral Examination is complete for safe-keeping until you submit your final copies to the Graduate College.

If the Final Oral Examination is unsuccessful, see the “Failure of a Comprehensive Examination or Final Oral Examination” sub-section (pg. 37) of the “Regulations for Doctor of Philosophy Programs” section of the Boise State University 2012-2013 Graduate Catalog.
Advisor Final Reading Approval

Following the Final Oral Examination, the defense committee may suggest changes and revisions they would like incorporated into the dissertation before the final copies are submitted to the Graduate College. Once the changes are incorporated, provide a copy of the revised dissertation to your major advisor (or defense chair); include at least three (3) copies of the Dissertation Final Reading Approval page, printed on 25% cotton paper, for the advisor to sign if the dissertation is found to be satisfactory to the advisor.

Once the Dissertation Final Reading Approval pages are signed, you may deliver them to the Graduate College for safe-keeping or turn them in with the format review copy of the dissertation.

Dissertation Format Review

A Dissertation Format Review must be completed before you can turn in final copies of the dissertation to the Graduate College. Once you have defended your dissertation successfully and have included all of the changes required by your committee, print out a copy of your completed and approved dissertation, single-sided, on regular paper and deliver it to the Graduate College.

The Dissertation Coordinator will review your dissertation and notify you when your reviewed dissertation is ready to be picked up from the Graduate College. At that time, the Dissertation Coordinator will provide you with a deadline for returning your final copies to the Graduate College.

No dissertation will be accepted for review after the “Last day to submit final signed copies of dissertation or thesis to Graduate Dean’s office” deadline. A review
copy of your dissertation must be approved by the Dissertation Coordinator before you are able to submit final copies to the Graduate College Thesis & Dissertation Office. Thus, if a dissertation is not submitted for review before this deadline, the student will not graduate during the commencement for that semester.

During a Dissertation Format Review, the Dissertation Coordinator will ensure the accuracy of the Table of Contents, List of Figures, and List of Tables; in addition, the Dissertation Coordinator verifies and cross references the internal and external reference citations. The Dissertation Coordinator will also verify the quality of the document submitted, and will spend extra time verifying the detail and quality of the abstract.

Verify the quality of your document before submitting the document for review. The Dissertation Coordinator is not a copy editor; rather, the Dissertation Coordinator is a quality assurance specialist. If the dissertation does not meet basic quality and dissertation preparation guidelines, the document will be rejected. The document will then require further revision and modification by the student before it can be resubmitted for review by the Dissertation Coordinator. Any document rejected from review might be in danger of not meeting the deadline for the desired graduation date.

Please allow 4-6 weeks for review of your document by the Coordinator of Theses and Dissertations.

**Submission of Final Copies**

*Note:* No final copies that have not received a format review will be accepted.

*Note:* The thesis or dissertation requirement of a graduate degree program is not considered satisfied until the Dean of the Graduate College approves its final version.
After incorporating all changes required by the Dissertation Coordinator, print at least three (3) copies of the final version of the dissertation on 25% cotton (watermarked) paper. Submit these hardcopies and one electronic copy (saved as a .doc, a .docx, or .pdf file) on a rewriteable CD. Additional copies can be included, as per the “Personal Copies” section below.

With the final copies, also include a completed Survey of Earned Doctorates (SED) and an Access Agreement for Theses and Dissertations. See the “Dissertation: Required Forms and Instructions” section below.

The final copies will undergo a further review by the Dissertation Coordinator in order to verify all changes required during the Dissertation Format Review were incorporated. If the desired changes were not incorporated, your final copies may need to be resubmitted with the required changes. During this secondary review, the Dissertation Coordinator also verifies all content and formatting to ensure nothing was missed during the review or printing.

Once the final hardcopies and electronic copy of the dissertation are verified, the Dissertation Coordinator will submit the dissertation to the Dean of the Graduate College for Final Review and Approval. The thesis or dissertation requirement of a graduate degree program is not considered satisfied until the Dean of the Graduate College approves its final version.

Once the Dean of the Graduate College approves the dissertation, he will sign the Dissertation Final Reading Approval pages and return the documents to the Dissertation Coordinator who will then finish processing the final copies.
Required Copies & Personal Copies

Three (3) official copies of the document are required by the Graduate College: 1) Library Archive Copy; 2) Library Circulation Copy; and 3) Department Copy. The required total binding fee for these official copies is $20.

The Graduate College will now assist with binding the personal copies of your dissertation. For the regular $10 per copy fee, the Graduate College will facilitate binding of the following additional copies of the dissertation:

- Committee and Advisor Copies (3-5 copies)
- Personal Copy for the Student (1)

The student must print out these copies and submit them to the Thesis & Dissertation Office along with payment for the binding fee.

ProQuest

The Graduate College no longer sends copies of the dissertation to ProQuest. If you would like to submit your dissertation to ProQuest, contact ProQuest directly: (http://www.proquest.com/en-US/productsbrands/pl_umidp.shtml).

Dissertation: Required Forms and Instructions

Forms Filled Out Prior to Defense

- **Application for Admissions to Candidacy form**—Fill out and submit this form to Graduate Admissions (located in 307 on the third floor of the Business building) the semester prior to the desired Graduation date. For example, for a May 2014 graduation, the Application for Admissions to Candidacy form should
be filled out in fall 2013. See the Academic Calendar for the exact deadline date.

This form is available here: http://gradcoll.boisestate.edu/forms/

- **Appointment of Supervisory Committee form**—Fill out and submit this form to Graduate Admissions (located in 307 on the third floor of the Business building) the semester prior to the desired Graduation date. This form is available here: http://gradcoll.boisestate.edu/forms/

Forms Filled Out During and/or Shortly After Defense

- **Dissertation Defense Committee Approval page**—Print out at least three (3) copies of this page on 25% cotton paper and have them signed by your committee members after you have successfully defended your dissertation. Drop off the signed pages to the Thesis & Dissertation Office (307D, third floor of Business building) as soon as the pages have been signed. The template for this page is available here: http://gradcoll.boisestate.edu/forms/

Forms to Include with Your Review Copy of the Dissertation

- **Culminating Activity Review Request form**—This form can be obtained from the Graduate College when you submit your thesis for review. It provides the Dissertation Coordinator with contact information and basic information regarding your thesis.

- **Dissertation Final Reading Approval pages**—Print at least three (3) copies of this page on 25% cotton paper and have them signed by your dissertation advisor
after you have incorporated any changes the committee requested during defense. The dissertation advisor’s signature ensures the final version of the dissertation is satisfactory to the committee. Turn these pages in to the Thesis & Dissertation Office (307D, third floor of Business building). The template for this page is available here: http://gradcoll.boisestate.edu/forms/

Forms to Include with Your Final Copies Delivered to the Graduate College

- **Electronic Dissertation Approval page**—Include this page in the electronic version of your dissertation, which will be submitted to the Graduate College on a rewriteable CD with your final hardcopies of your dissertation. This page replaces the signed Dissertation Defense Committee Approval page and Dissertation Final Reading Approval page in the electronic copy of the dissertation. The example of this page is available here: http://gradcoll.boisestate.edu/forms/

- **Submission of Culminating Activity and Binding Request**—Fill out and submit this page with the final copies of your dissertation. The Dissertation Coordinator will provide this form when your review copy of the dissertation is returned to you. This form provides additional contact information and bindery information (both for your submitted hardcopies and for additional personal copies of the dissertation you might desire to obtain on your own).

- **Graduate College Access Agreement for Thesis or Dissertation form**—Fill out and include this form with the final copies of your dissertation when you deliver
This form provides you with the opportunity to dictate how you would like your
electronic dissertation accessed in ScholarWorks. Both you and your advisor must
sign it. If there are questions regarding this form and the completion of this form,
please contact the Dissertation Coordinator, Jodi Chilson, via e-mail
(jodichilson@boisestate.edu) or phone (208-426-3604). The form is available
here: http://gradcoll.boisestate.edu/forms/

- **Survey of Earned Doctorates (SED) form**—Fill out and include this form with
  the final copies of your dissertation when you deliver them to the Thesis &
  Dissertation Office (307D, third floor of Business building). The Dissertation
  Coordinator will provide this form when the review copy of the dissertation is
  returned to you. This form is sent to the National Organization for Research at the
  University of Chicago and will be published in a Summary Report detailing all of
  the doctorates awarded in the United States.

**ETD Process & ScholarWorks**

In addition to the printed copies of your thesis/dissertation, you are expected to
submit an electronic copy of your thesis/dissertation on a rewriteable CD. The file must
be a .DOC, a .DOCX, or a .PDF file, and must be a single file (rather than a collection of
multiple files). Additional supporting files may be included on the CD for upload into
ScholarWorks; however, the thesis/dissertation itself must be contained in a single file.

When submitting the electronic copy, you must also submit a completed and
signed copy of the Access Agreement for Thesis and Dissertations.
ScholarWorks

ScholarWorks is an electronic database for thesis/dissertation storage. When a document is uploaded into this database, the document becomes globally accessible. This means your research and findings are immediately accessible and made a part of the global discourse for your field. The document can be searched via worldwide search engines like Google Scholar.

The availability of your document can be limited, as you desire, via the options provided on the Access Agreement.

Keywords & Abstracts

Because ScholarWorks provides a means for your thesis/dissertation to globally enter the discourse for your field, the keywords you set for your thesis/dissertation and the content of your abstract are extremely important. Through keywords and the content of your abstract, the reader will determine whether or not they want to download your thesis/dissertation. If the keywords are inaccurate, the reader may not be able to find your document. If the abstract is not detailed, the reader may not download and read your research and finding.

General Deadlines: Thesis & Dissertation

The tables on the following pages contain only general deadlines; see the Academic Calendar and consult with your advisor for specific deadlines and how they relate to your thesis/dissertation process.
<table>
<thead>
<tr>
<th>Date</th>
<th>Event</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>October 15</td>
<td>Last day to submit &quot;Application for Admission to Candidacy form&quot; <a href="http://gradcoll.boisestate.edu/forms/">http://gradcoll.boisestate.edu/forms/</a></td>
<td>Note: Please make sure your Supervisory Committee form (<a href="http://gradcoll.boisestate.edu/forms/">http://gradcoll.boisestate.edu/forms/</a>) has been turned in well before this date; the Supervisory Committee form must be turned in before the Application for Admission to Candidacy form.</td>
</tr>
<tr>
<td>January 28</td>
<td>Last day to apply for graduation for May 2013 graduation (via My.BoiseState)</td>
<td></td>
</tr>
<tr>
<td>March 15</td>
<td>Last day to defend thesis/dissertation.</td>
<td></td>
</tr>
<tr>
<td>April 1</td>
<td>Last day to submit a review copy of the thesis/dissertation to the Graduate College.</td>
<td>Note: Review Copy of Thesis/Dissertation - Once you have defended your thesis/dissertation and have incorporated the changes requested by your committee, print out a review copy of your thesis/dissertation (single-sided) on regular paper and submit it to the Graduate College for review. A review copy of your thesis will not be accepted after April 1st. You cannot graduate without review and approval of your thesis.</td>
</tr>
<tr>
<td>May 10</td>
<td>Last day to submit final copies of thesis/dissertation to the</td>
<td></td>
</tr>
</tbody>
</table>
Graduate College. Final copies to include: three (3) official hardcopies printed on 25% cotton paper and a rewriteable CD with the electronic copy.

No thesis/dissertation will be accepted after this date for May 2013 graduation.

Table 1.2  August 2013 Graduation – Thesis & Dissertation Process Deadlines

<table>
<thead>
<tr>
<th>For August 2013 Graduation</th>
</tr>
</thead>
<tbody>
<tr>
<td>March 4</td>
</tr>
<tr>
<td>Last day to submit &quot;Application for Admission to Candidacy form&quot; (<a href="http://gradcoll.boisestate.edu/forms/">http://gradcoll.boisestate.edu/forms/</a>).</td>
</tr>
<tr>
<td>Note: Please make sure your Supervisory Committee form (<a href="http://gradcoll.boisestate.edu/forms/">http://gradcoll.boisestate.edu/forms/</a>) has been turned in well before this date; the Supervisory Committee form must be turned in before the Application for Admission to Candidacy form.</td>
</tr>
<tr>
<td>June 13</td>
</tr>
<tr>
<td>Last day to apply for graduation for August 2013 graduation (via My.BoiseState).</td>
</tr>
<tr>
<td>June 17</td>
</tr>
<tr>
<td>Last day to defend thesis/dissertation.</td>
</tr>
<tr>
<td>July 8</td>
</tr>
<tr>
<td>Last day to submit a review copy of the thesis/dissertation to the Graduate College. The thesis/dissertation copy submitted for review must be defended and approved via the Final Reading Approval of the thesis/dissertation chair.</td>
</tr>
<tr>
<td>Note: Review Copy of Thesis/Dissertation - Once you have defended your thesis/dissertation and have incorporated the changes requested by your committee, print out a review copy of your</td>
</tr>
</tbody>
</table>
thesis/dissertation (single-sided) on regular paper and submit it to the Graduate College for review. A review copy of your thesis will not be accepted after July 8th. You cannot graduate without review and approval of your thesis.

<table>
<thead>
<tr>
<th>Date</th>
<th>Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>August 5</td>
<td>Last day to submit final copies of thesis/dissertation to the Graduate College. Final copies to include: three (3) official hardcopies printed on 25% cotton paper and a rewriteable CD with the electronic copy. No thesis/dissertation will be accepted after this date for August 2013 graduation.</td>
</tr>
</tbody>
</table>

Table 1.3  December 2013 Graduation – Thesis & Dissertation Process Deadlines

For December 2013 Graduation

<table>
<thead>
<tr>
<th>Date</th>
<th>Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>June 28</td>
<td>Last day to submit &quot;Application for Admission to Candidacy form&quot; (<a href="http://gradcoll.boisestate.edu/forms/">http://gradcoll.boisestate.edu/forms/</a>). Note: Please make sure your Supervisory Committee form (<a href="http://gradcoll.boisestate.edu/forms/">http://gradcoll.boisestate.edu/forms/</a>) has been turned in well before this date; the Supervisory Committee form must be turned in before the Application for Admission to Candidacy form.</td>
</tr>
<tr>
<td>August 30</td>
<td>Last day to apply for graduation for December 2013 graduation (via My.BoiseState).</td>
</tr>
<tr>
<td>Oct. 18</td>
<td>Last day to defend thesis/dissertation.</td>
</tr>
<tr>
<td>Date</td>
<td>Event</td>
</tr>
<tr>
<td>--------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Nov. 8 | Last day to submit a review copy of the thesis/dissertation to the Graduate College. The thesis/dissertation copy submitted for review must be defended and approved via the Final Reading Approval of the thesis/dissertation chair.  

*Note:* **Review Copy of Thesis/Dissertation** - Once you have defended your thesis/dissertation and have incorporated the changes requested by your committee, print out a review copy of your thesis/dissertation (single-sided) on regular paper and submit it to the Graduate College for review. A review copy of your thesis will not be accepted after July 8th. You cannot graduate without review and approval of your thesis. |

| Dec. 13 | Last day to submit final copies of thesis/dissertation to the Graduate College. Final copies to include: three (3) official hardcopies printed on 25% cotton paper and a rewriteable CD with the electronic copy.  

No thesis/dissertation will be accepted after this date for December 2013 graduation. |

---

**On-Campus Services for Students**

There are several free services on campus to assist with research and writing for graduate students. These include two main service providers: The Writing Center and the Albertsons Library. Other services may be provided as per each academic unit or department; consult with your advisor and department regarding other services that might be available.
The Writing Center

The Writing Center is a service center provided by the English Department for all students at Boise State University. The Writing Center will assist any writer with any stage of the writing process through one-on-one or email consultations. Please see the Writing Center website for more information or to set up an appointment:


Albertsons Library

The Albertsons Library on campus provides research and research knowledge assistance to any Boise State University student. The Albertsons Library does this through three main means: 1) one-on-one consultation via walk-in service or online chat; 2) one-on-one consultation via your library liaison; and 3) through informal workshops.

One-on-One or Email Consultation via Walk-in Service or Online Chat

The Albertsons library is well staffed with friendly and knowledgeable librarians, who will be able to assist or direct you. There is also 24-hour assistance available via chat from the library, so you can ask questions and receive immediate research assistance anytime from any location. Please see the Albertsons Library homepage for these and other services.

Please see the following website for service options at the Albertsons Library:

http://library.boisestate.edu/reference.shtm

Library Liaison

Each department is assigned a library liaison, which means for each department a librarian is assigned who specializes in the subject matter, reference requirements, and
research knowledge for that particular field. These library liaisons are available to assist the student in their assigned subject and are an invaluable source for the graduate students. The library liaison is available to answer questions and provide consultation via e-mail, phone, and in-person consultation. To find the library liaison for your department, consult the Albertson’s Library website, and click “Contact Your Librarian”; or, see the following link: http://library.boisestate.edu/CollDev/liaisons.shtm.

**Library Workshops**

A number of workshops will be offered throughout the semester. Please contact your library liaison for information regarding these workshops and other resources for research and citation assistance. These workshops in the past have focused on topics such as the following: Using EndNote, Copyrights, Citing Sources, etc.
CHAPTER TWO: THESIS/DISSERTATION ELEMENTS, 
AND STANDARDS AND GUIDELINES

Overview

The student is responsible for all of the content and formatting of the thesis/dissertation. A student may acquire assistance for formatting and copyediting of the document, but all changes directly to the content are the student’s responsibility. See the following guidelines for formatting the thesis/dissertation according to the Boise State University Graduate College standards. Many students may find it easiest to use our document template, which can be found on the Thesis & Dissertation website: http://gradcoll.boisestate.edu/thesisdissertation/template/. Detailed instructions for using the template can be found in Chapter Three. Also, please note that this manual is formatted with the same styles and standards required in your thesis/dissertation and can be used as an example of proper formatting.

Note: Any thesis/dissertation failing to meet these standards and guidelines may be rejected during format review.

Please also consult with your thesis/dissertation chair and the styles guide specific to your department and discipline for additional guidelines. Unless approved by the Graduate College, you are expected to adhere to all required formatting guidelines in this handbook.
Types of Theses and Dissertations

There are two major types of thesis and dissertation styles: 1) traditional, and 2) article-based thesis or dissertation. For the traditional method, follow the general styles and standards below. For the article-based thesis or dissertation, see the “Article-Based Thesis or Dissertation Guidelines” below.

General Standards and Guidelines for Traditional Theses and Dissertations

Order of Thesis/Dissertation Elements in Print Copy

The order of some of these elements may vary depending on your discipline/field. Please note such differences on your contact information sheet when submitting your review copy to the Graduate College; this difference must be approved by your major advisor. Unless otherwise approved, the order of your thesis/dissertation must be as follows.

Details regarding the composition of these elements are provided in the “Thesis/Dissertation Elements” section below.

*Note: Not all of the elements in this list are required. All required elements are bolded.*

The order of thesis/dissertation elements is as follows:

- Title Page
- Copyright Page
- Defense Committee Approval Page
- Final Reading Approval Page
• Dedication

• Acknowledgements

• Autobiographical Sketch of the Author

• Abstract

• Table of Contents

• List of Tables (required if you have tables)

• List of Figures (required if you have figures)

• List of Graphs (required if you graphs)

• List of Plates or Photos

• List of Maps

• List of Abbreviations

• List of Symbols

• Text

• End Notes, if not in text or at end of chapters

• References, Bibliography, or Works Cited

• Appendix

• Glossary
Order of Thesis/Dissertation Elements in the Electronic Copy

The only difference between the submitted print copies and the electronic copy are their approval pages. Instead of the signed Defense Committee Approval page and the Final Reading Approval page, the electronic copy of the document should include an electronic approval page. This page includes the information provided on these two pages, sans the signatures, which allows the student to submit a true electronic copy of the document to the Graduate College for upload into ScholarWorks. See “Appendix A” for an example of this electronic approval page.

Also, see the Graduate College website for a template of this electronic approval page to include in the electronic copy of your thesis/dissertation:

http://gradcoll.boisestate.edu/forms/

Note: You may notice that having a one-page approval page in your electronic copy may alter your document’s pagination. For consistency between both the printed and electronic copies of your document, count the two signed approval pages as a single page when setting your printed copy’s pagination.

Article-Based Theses and Dissertation Guidelines

Note: If you plan to submit an article-based thesis or dissertation, please contact the Thesis and Dissertation Office, as pre-approval may be required.

Also called the “multi-paper format,” a thesis or dissertation in this style is composed of a few to several articles or research papers. These articles or research papers can be previously published, in press, or unpublished, but the student MUST be the sole or major contributor. Articles and papers for which the student is not the sole or major
contributor cannot be used in the body of the thesis or dissertation, but may be used in the appendices.

The student is responsible for acquiring all copyright permissions, including permission by the copyright holder (often the journal in which the article was published) and permission from the contributing authors, not including those on the supervisory committee. The permissions letters must be included in the appendices of the thesis or dissertation.

See the appendices also for examples of the permissions letters that will need to be sent and collected from the copyright holders and contributing authors.

The article-based thesis or dissertation MUST still adhere to the formatting styles and standards required by the Graduate College Thesis and Dissertation Office, such as margins, document styles, thesis elements, etc.

**Abstract**

Each article or paper will likely have an abstract already included. However, for a thesis or dissertation composed of chapter/articles, there must be an abstract in the front matter of the document. This abstract extends over the entire thesis or dissertation and should discuss succinctly the work of the entire thesis or dissertation.

**Introduction and Conclusion**

The article-based thesis or dissertation should begin with an Introduction that clearly summarizes the research and information the reader will find in the thesis or dissertation chapters/articles. In addition, the thesis or dissertation should conclude with a Conclusion chapter that summarizes the end results and further research discoveries.
Chapter/Article Variation from Published Version

When copyright is acquired from the copyright holder, it is understood that the content of the thesis or dissertation has been modified—whether through minor changes such as grammar and style or through greater modifications to data and figures.

References

As the article-based thesis or dissertation contains articles that are likely published or pending publication in different journals, each chapter should have its own references list, which should appear after the chapter. The in-text citations and references list are prepared according to the standards followed for each chapter.

In addition, if the Introduction and Conclusion chapter contain citations, ensure there is a references list for these two chapters as well. Ensure the same style of citation method used in the Introduction is used for the Conclusion chapter, and clearly indicate which method style is used for these chapters when submitting your review copy to the Graduate College Thesis and Dissertation Office.

For Articles Not Yet Published

For articles in press, meaning that they have been accepted and are pending publication, ensure you acquire copyright permissions from the copyright holder and contributing authors in the same manner for published articles. In addition, ensure you follow the copyright regulations for that journal.

For articles that have been submitted to the journal or have not yet been submitted, ensure you are aware of the journal’s publication limitations with regard to thesis or dissertation submission and publication.
For example, when submitting to the American Chemical Society (ACS) and journals that use the ACS styles and standards, the student will likely need to select Option 3 on the Access Agreement for a Thesis or Dissertation, which is a required form that must be submitted to the Graduate College Thesis and Dissertation Office. This option embargoes the final thesis or dissertation for two years, which will allow ample opportunity for the article to be submitted and published by the ACS-based journal.

Others like the Environmental Science and Technology journal, for instance, requires that the article, once published in the journal, not be made public in the thesis or dissertations for at least one year, after which time the journal provides open access.

**Thesis/Dissertation Elements**

**Title Page**

The title page is considered page i in the thesis/dissertation; however, no page number should be listed on this page.

See Appendix A for an example of a correctly formatted title page; ignore the page number in the upper-right corner of this example page as the numbering is for this handbook only. See Table 2.1 for details regarding the elements of the title page and the formatting required.

**Table 2.1 Formatting Title Page Elements**

<table>
<thead>
<tr>
<th>Element</th>
<th>Formatting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The title should be centered and listed in all caps two inches from the top of the page. Titles should be clear and concise and should clearly indicate the focus of the thesis/dissertation. A reader should be able to</td>
</tr>
</tbody>
</table>
determine the subject matter and the field simply by reading the title.

For example:

**Unclear Title:**  STUDENT JOURNALS

**Clear Title:**  USING STUDENT JOURNALS IN THE CLASSROOM TO ENHANCE STUDENT LEARNING

When a title takes more than one line on the title page, break the title logically into two or more lines. Do not end a title line with a preposition or conjunction.

For example:

**Incorrectly Broken Title:**

USING STUDENT JOURNALS IN THE CLASSROOM TO ENHANCE STUDENT LEARNING

**Correctly Broken Title:**

USING STUDENT JOURNALS IN THE CLASSROOM TO ENHANCE STUDENT LEARNING

or

USING STUDENT JOURNALS IN THE CLASSROOM TO ENHANCE STUDENT LEARNING

Avoid the use of phrases such as “A Study of,” “Laboratory Investigations of,” and other such introductory phrases in the title.

Abbreviations and symbols should not be used in titles unless they are of standard usage and recognized in the discipline.

<table>
<thead>
<tr>
<th><strong>Author’s Name</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>The author’s full name should be placed in the center of the page and must be the same name as is listed officially in the student’s record.</td>
</tr>
<tr>
<td>The author’s name must be identical to the primary name listed in</td>
</tr>
</tbody>
</table>
My.BoiseState. If you wish to use a different official name, you must change the name in My.BoiseState and in the official record in order to have this different name listed on the title page.

<table>
<thead>
<tr>
<th>Degree Title and Degree Fulfillment Paragraph</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Thesis:</strong> The degree title and degree fulfillment paragraph must be centered on the bottom third of the page. Ensure the correct document type is listed: thesis or degree. Also, ensure the correct degree title is listed; double-check this degree title against the Graduate catalogue. This degree title must be listed exactly (including punctuation or no punctuation) as it is listed in the Graduate Catalogue.</td>
</tr>
</tbody>
</table>

The text of this paragraph is as follows, and must be listed as such, including the same capitalization and punctuation:

```
A thesis
submitted in partial fulfillment
of the requirements for the degree of
Master of [Arts or Sciences] in [Discipline], Emphasis
Boise State University
```

For example:

```
A thesis
submitted in partial fulfillment
of the requirements for the degree of
Master of Fine Arts in Creative Writing
Boise State University
```

Another example:

```
A thesis
submitted in partial fulfillment
of the requirements for the degree of
Master of Science in Exercise and Sports Studies, Biophysical Studies
Boise State University
```
**Dissertation:** The degree title and degree fulfillment paragraph must be centered on the bottom third of the page. Ensure the correct document type is listed: thesis or dissertation. Also, ensure the correct degree title is listed; double-check this degree title against the Graduate catalogue. This degree title must be listed exactly (including punctuation or no punctuation) as it is listed in the Graduate Catalogue.

The text of this paragraph is as follows and must be listed as such, including the same capitalization and punctuation:

```
A dissertation
submitted in partial fulfillment
of the requirements for the degree of
Doctor of [Arts or Sciences] in [Discipline], Emphasis
Boise State University
```

For example:

```
A dissertation
submitted in partial fulfillment
of the requirements for the degree of
Doctor of Education in Curriculum and Instruction
Boise State University
```

Another example:

```
A dissertation
submitted in partial fulfillment
of the requirements for the degree of
Doctor of Philosophy in Electrical and Computer Engineering
Boise State University
```
Month and Year

This text should be centered and listed exactly one inch from the bottom of the page and two double spaces beneath the degree title and degree fulfillment paragraph.

The month listed should be one of three months, depending on the month you are graduating: December, May, or August. There should be no comma between the month and the year listed.

Incorrect: Spring 2014
Incorrect: Spring, 2014
Correct: May 2014

Copyright Page

Type the author’s name exactly as it appears on the title page. This page is considered page ii; however, this page should not be paginated.

See Appendix A for an example of the copyright page; ignore the page number in the upper-right corner of this example page as the numbering is for this handbook only.

Copyrights

As the author of a thesis/dissertation, you hold common law copyright before its publication, and no one can legally copy it without your consent. When the bound thesis/dissertation is circulated in the University Library, it is considered a published document. By entering a copyright notice in the thesis/dissertation on the page following the title page, you will have statutory copyright. If you wish to copyright your thesis/dissertation in this way, each copy of the thesis/dissertation must include this page.

To enforce copyright, in the case of infringement, a copyright must be registered with the United States Copyright Office. Register the copyright as soon as possible after
publication (i.e., shelving of the document in the library). To register your copyright, write to the U.S. Copyright Office at the following address and ask for a copy of Form TX, “Application for Registration of a Claim to Copyright”:

U.S. Copyright Office
The Library of Congress
Washington, D.C. 20559

Complete the form and return it with one soft-bound copy of your thesis/dissertation and the appropriate fee to the U.S. Copyright Office. You are responsible for the registration of copyright; the University cannot do it for you.

See the Library of Congress website for additional information regarding copyrights: http://lcweb.loc.gov/copyright/.

Creative Commons Licensing

In addition to your copyright, you may choose to apply a Creative Commons (CC) license to your thesis/dissertation. CC licenses protect your rights to ownership yet allow for greater freedom in sharing information. You as the author can customize the way you allow readers to use your work by choosing from a set of free licenses that dictate terms of usage. The licenses contain different combinations of the following four attributes:

- Attribution: Requires users to credit you as the creator of your original work. All CC licenses require attribution.
- No Derivatives: Prohibits users from altering your work.
- Non-Commercial: Allows users to use your work solely for non-commercial purposes.
- Share Alike: Requires any users who use your work to license their new creations under identical terms.
CC Licenses provide an easier way for users to access and use your work, resulting in a wider distribution of your information and talents. You still have control over the way your work is used, but CC licenses streamline the permission process.

All CC licenses are non-exclusive, meaning that you will still be able to enter into separate, non-exclusive contracts if you so desire (such as for commercial gain). However, you will not be able to enter into exclusive contracts, even if you stop distributing your work under the CC license. All copies of your work already in circulation would still be available to the public under the terms of the original license.

To obtain a CC license, visit http://creativecommons.org/choose. Here you will be asked to answer a few questions that determine the type of license best suited for you. Once you have filled out and submitted your answers, a license code will be generated for you that can be copied and inserted into your document. This code will replace the traditional copyright information. See Appendix A for an example of how to include a CC license in your work.

For more information on Creative Commons licensing, visit http://creativecommons.org.

Defense Committee Approval Page

Note: The three (3) official copies of the Defense Committee Approval page must be printed on 25% cotton paper, and signed by the committee in black ink. If the Defense Committee Approval page(s) are not printed on 25% cotton paper, the student will have to resubmit the Defense Committee Approval pages, printed on the correct paper, even if the incorrect copies are already signed.

Note: Ensure the student’s name and all committee member names appear correctly on the Defense Committee Approval page(s). If these names are not correct, the Defense Committee Approval pages will have to be resubmitted.
by the student even if the incorrect version is already signed and printed on correct paper.

The thesis/dissertation requires two approval pages; the Defense Committee Approval page is the first of these two approval pages included in the print copy of the thesis/dissertation. At the time of the defense, print three (3) copies of this Defense Committee Approval page on 25% cotton paper; if the defense is satisfactory, the committee should sign all three of these forms. Once these forms are signed, bring these to the Graduate College for proper storage.

The Defense Committee Approval page is signed by the defense committee in response to a satisfactory oral defense of the thesis/dissertation. The committee may still desire changes to the thesis/dissertation before final submission of the work to the thesis/dissertation chair. You must make all the committee-requested changes to the thesis/dissertation before submitting the thesis/dissertation to your thesis/dissertation chair for final reading approval.

See Appendix A for an example of the Defense Committee Approval page.

See the Graduate College website for a template of this document; ensure you correctly select the thesis or dissertation template, depending on which document you are completing: http://gradcoll.boisestate.edu/forms/.

Final Reading Approval Page

Note: The three (3) official copies of the Final Reading Approval page must be printed on 25% cotton paper, and signed by the thesis/dissertation chair in black ink. If the Final Reading Approval page(s) are not printed on 25% cotton paper, the student will have to resubmit the Defense Committee Approval pages, printed on the correct paper, even if the incorrect copies are already signed.
Note: Ensure that both the student’s name and thesis/dissertation chair’s name appear correctly on the Final Reading Approval page(s). If these names are not correct, the Final Reading Approval pages will have to be resubmitted by the student even if the incorrect version is already signed and printed on correct paper.

The thesis/dissertation requires two approval pages; the Final Reading Approval page is the second of these two approval pages included in the print copy of the thesis/dissertation. After you have made all of the changes requested by the committee after the defense, submit a copy of your thesis/dissertation to your thesis/dissertation chair for final reading approval. Also, print three (3) copies of the Final Reading Approval page on 25% cotton paper to provide to your thesis/dissertation chair. Once the thesis/dissertation chair has confirmed all requested changes were made and the thesis/dissertation is satisfactory, the thesis/dissertation chair will sign the three (3) copies of the Final Reading Approval page.

Submit the Final Reading Approval pages to the Graduate College with the review copy of your thesis/dissertation. See the “Thesis Format Review” or “Dissertation Format Review” section in Chapter One for more information regarding the review.

See Appendix A for an example of the Final Reading Approval page.

See the Graduate College website for a template of this document; ensure you correctly select the thesis or dissertation template, depending on which document you are completing: http://gradcoll.boisestate.edu/forms/.
Acknowledgements

Please ensure that all individuals listed with a doctoral degree are acknowledged as such with the appropriate title listed before their name. If the acknowledged person has multiple titles, use the highest title marker, as appropriate.

Please see the following for the most common Acknowledgements errors.

Incorrect: Doctors Elizabeth Barber and Fred MacIntyr

Special thanks to my committee members: Elizabeth Barber and Fred MacIntyr.

Correct: Dr. Elizabeth Barber and Dr. Fred MacIntyr

In addition, if selections of this thesis/dissertation appear in publication elsewhere, please indicate this in the Acknowledgements.

Autobiographical Sketch of the Author

The Autobiographical Sketch of the Author is not a biographical element to list the life history of the author. Rather, this element should be utilized to highlight the academic and professional career of the author. As appropriate, list previous publications and conference papers in this section.

Abstract

An abstract is required. The abstract should include the following: a definitive-statement of the problem; a brief description of the research method(s) and design; major findings, including significance or lack thereof; and conclusions. The abstract is limited to approximately 500 words.
Because of the increasing reliance on electronic media, the abstract is crucial. The abstract is typically the first thing, other than the title, a reader sees, and it largely determines whether or not the document will be read. If an abstract does not clearly outline the thesis of the work, the methods and considerations of the research, and the research and findings contained in the document, the thesis/dissertation will likely not be read.

See the styles guide recommended by your department, field, and advisor for more information regarding the abstract. Also, please see the ANSI/NISO Z39.14 - Guidelines for Abstracts listing in the “Bibliography” of this handbook; this reference has detailed explanations and examples of abstracts.

Table of Contents

The Table of Contents should only list Heading 1, Heading 2, and Heading 3 listings. All other headings and subheadings are omitted from the Table of Contents page. Do not list the title page, copyright page, approval pages, and the Table of Contents on the Table of Contents page.

See Appendix A for an example of a Table of Contents.

Also, see Chapter 3 for instructions on creating Dot Leaders in Word if you are manually creating your Table of Contents.

List of Tables & List of Figures

If the document contains tables and/or figures, these items must be listed in a List of Tables and/or List of Figures, respectively. See Appendix A for an example of a List of Tables and a List of Figures.
References, Bibliography, or Works Cited

For the References, Bibliography, or Works Cited, use the citation method suggested by your discipline and the corresponding styles guidelines. See the styles guide for your discipline to determine which type of References list you need and what you must include in your list.

It is the student’s responsibility to verify that the spelling of each reference and the year of publication cited in the text, figures, and tables agree with the corresponding entries in the references list.

Unless your department requires a specific style that has been approved by the Graduate College, all reference lists should be typed single-spaced with double spacing between entries. The first line of each reference is flush with the left margin and the succeeding lines are indented; i.e. use hanging indent for the entries.

See the “Citation and Reference Standards and Guidelines” section below for details regarding this section. Also, see Appendix A for an example of a Works Cited page in MLA.

Appendix

The appendix should have a title page preceding the appendix content. This title page will contain the words “APPENDIX” and the corresponding letter according to the number of appendices. Below this Heading 1 title, a corresponding subheading (Heading 2) should indicate what is included in the appendix; this subheading should be a single clear title.
In the Table of Contents, this appendix will be listed according to the title page pagination. If there is a single appendix, then a corresponding alpha-numeric number is not needed. For example, if there is only one appendix, the title (Heading 1) will simply be “APPENDIX.” If there are multiple appendices, the titles (Heading 1s) will be as follows, depending on the number of appendices: APPENDIX A, APPENDIX B, APPENDIX C, etc.

See the appendices in this handbook for examples; also see the Table of Contents in this handbook for examples of how to format the appendices in the Table of Contents.

**Formatting Styles and Guidelines**

**General Formatting Guidelines**

The table below outlines general formatting guidelines. Note that this manual is formatted with the same styles and standards required in your thesis/dissertation and can be used as an example of proper formatting. Also, please see Appendix A for example pages.

*Note:* Any templates for approval pages on the Graduate College website should not be modified to fit the General Formatting Guidelines outlined below. Change only the names and the gendered pronouns. Do not change margins or add page numbers.

**Table 2.2 General Formatting Guidelines**

<table>
<thead>
<tr>
<th>General Formatting Guidelines</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Paper</strong></td>
</tr>
<tr>
<td>Paper must be 8½ x 11, bright white, 25% cotton fiber paper. This paper should be either 20- or 24-pound weight. Ensure the paper has the 25% cotton watermark. Recycled paper is not acceptable.</td>
</tr>
</tbody>
</table>
### General Formatting Guidelines

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Margins</strong></td>
<td><strong>Note:</strong> Final paper copies submitted that are not on 25% watermarked paper will be returned to the student.</td>
</tr>
<tr>
<td></td>
<td><strong>Left Margin</strong> = 1.5 inches</td>
</tr>
<tr>
<td></td>
<td><strong>Top Margin</strong> = 1 inch, unless it precedes a Heading 1, in which case, the top margin is 2 inches</td>
</tr>
<tr>
<td></td>
<td><strong>Right Margin</strong> = 1 inch</td>
</tr>
<tr>
<td></td>
<td><strong>Landscape-Oriented Pages</strong> = Top Margin: 1.5 inches, all other margins: 1 inch</td>
</tr>
<tr>
<td><strong>Page Numbers</strong></td>
<td>Page numbers should be the same font and font size as the text.</td>
</tr>
<tr>
<td></td>
<td><strong>Front Matter:</strong> Page numbers for the front matter should consist of Roman Numerals in the bottom center of the page, 1 inch from the bottom of the page. Page counting starts with the title page; however, the title page, copyright page, and approval pages should not contain a page number.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For consistency between both the printed and electronic copies of your document, count the two signed approval pages as a single page when setting your printed copy’s pagination.</td>
</tr>
<tr>
<td></td>
<td><strong>Text &amp; Back Matter:</strong> Page numbers for the text and back matter should consist of alpha-numeric numbers and should begin with 1 on the first page of the thesis/dissertation content.</td>
</tr>
<tr>
<td>General Formatting Guidelines</td>
<td></td>
</tr>
<tr>
<td>-------------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>Page numbers for text and back matter should be in the upper-right corner of the page.</strong></td>
<td></td>
</tr>
</tbody>
</table>

If the appendix is supplemental information to the manuscript, page numbers will continue in numerical order. If the appendix or project is a separate guide or manual that may be published, it will have its own title page and table of contents, and the page numbers will start over.

See Chapter 3 for instructions on setting page numbers and creating portrait-oriented page numbers for landscape-oriented pages.

<table>
<thead>
<tr>
<th><strong>Headings</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Heading 1:</strong> Heading 1s, which includes front matter listings, Chapter titles, and back matter listings should begin a new page and should be listed in all caps in the center of the page, 2 inches from the top of the page. These headings include, but are not limited to, the following examples: DEDICATION, ABSTRACT, TABLE OF CONTENTS, CHAPTER 1, REFERENCES, APPENDIX.</td>
</tr>
</tbody>
</table>

**Heading 2:** Follow Heading 1s, and should be in bold and title-capped and listed in the center of the page.

**Heading 3:** Should be underlined and title-capped and are aligned left on the page.

**Heading 4:** Should be underlined and title-capped and should be indented once.

**Heading 5:** Should be underlined and title capped and should be indented twice. This heading should end in a period, and the paragraph text should start on the same line.
<table>
<thead>
<tr>
<th>General Formatting Guidelines</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Paragraph</strong></td>
</tr>
<tr>
<td>For example:</td>
</tr>
<tr>
<td>This Is a Heading 5 Example. This is where the content following this heading would start, and the paragraph and sentences would continue beneath this heading.</td>
</tr>
<tr>
<td><strong>Font &amp; Font Size</strong></td>
</tr>
<tr>
<td>Font: The font should be a serif font. Times New Roman is the standard and preferred font; however, Times and Garamond are also acceptable.</td>
</tr>
<tr>
<td>Font Size: 12-point font is required.</td>
</tr>
<tr>
<td><strong>MISC</strong></td>
</tr>
<tr>
<td>Print Sides: The document should be printed single-sided.</td>
</tr>
<tr>
<td>Spacing: The document content should be double-spaced. Single-space extended quotes (block quotes), footnotes, and bibliography, but double-space between paragraphs or items.</td>
</tr>
<tr>
<td>Also, single-spacing or 1.5 spacing may be used in tables or lists to assist in readability and clarity of content.</td>
</tr>
<tr>
<td>Text Alignment: All text should be aligned left.</td>
</tr>
</tbody>
</table>
**General Formatting Guidelines**

| Justified is not acceptable, unless the document is created in LaTex. |

**Block Quotes**

Occasionally, a quote from a referenced work will need to be used in a thesis/dissertation that is more than two (2) lines in length. In these instances, a block quote should be used to clearly designate to the reader what the quoted material is and where the voice of the author enters. These block quotes not only clarify references but also provide a clean and clear look in the document, which a long quote set in the paragraph text would hinder.

All block quotes should be indented and single spaced. An example of such formatting for a block quote is as follows:

>This is an example of a block quote. This is a continued sentence of the block quote, and this is a continuation of that sentence. This is an example of a block quote. This is a continued sentence of the block quote, and this is a continuation of that sentence. This is an example of a block quote. (Saunders 28)

The text following the block is not indented, but is aligned left as it is a continuation of the paragraph. The block quote should not have quote marks, as convention indicates that the indented block is already designated as a quote.

Consult your discipline’s styles guide and your thesis/dissertation advisor to verify how a source is cited in a block quote.
Bullet Lists

The bullet should consist of a solid circle, and the bullet list should be indented one space, equivalent to the indentation of the first line of the paragraph that precedes it.

For example:

- This is a properly formatted bullet item.
- This is a properly formatted bullet item.
- This is a properly formatted bullet item.
- This is a properly formatted bullet item.

Citations

See the “Citation and Reference Standards and Guidelines” section below.

Cross-References

Occasionally, there is need for an internal reference to a figure, a table, or another section of the document. In these instances, use the following standards and guidelines.

The most important thing in these internal references is consistency.

When referring the reader to another section, figure, or table, ensure the location of this referred-to item is clear. This will determine how much information is required in your reference. For example, when referring a reader to something within this chapter of the handbook, a reference could say simply: “See Table 2.1.” or “See ‘Cross-References’ above.”
If however, the referred to item is in another chapter or major section of the
document, provide more information for the reader to easily find the section. For
example,

See the example Table of Contents in “Appendix A.”

Or,


If the location of the item is inherent in the reference, then a detailed cross-
reference is unnecessary. For example, if a cross-reference is Chapter Two is asking the
reader to refer to a figure in Chapter One, if the figures are numbered according to the
chapter and number of the figure in that chapter, than only the reference to the figure is
required:

See Figure 1.2.

Rather than,

See Figure 1.2 in Chapter One.

Margins

See “Table 2.1 General Formatting Guidelines” above.

Notes

If your document contains notes, the note items should be indented one space and
the note should be set up with a hanging indent. The note should be in italics to
differentiate the text from the document body. The following is an example:
Note: This is an example of a note. A longer note will be indented with a hanging indent to clearly indicate the note text.

Number Lists

The number should start at 1 and should consist of no other ornamentation; the number list should be indented one space, equivalent to the indentation of the first line of the paragraph that precedes it. For example:

1. This is a properly formatted number list item.
2. This is a properly formatted number list item.
3. This is a properly formatted number list item.
4. This is a properly formatted number list item.

Page Numbers

See “Table 2.1 General Formatting Guidelines” above.

Paragraph

See “Table 2.1 General Formatting Guidelines” above for basic formatting guidelines for paragraphs.

In addition, paragraph text that follows a list or block quote should not be indented as it is a continuation of the paragraph preceding the list or block quote. See the “Block Quote” section above for an example.

Figures

Figures should be centered on the page. Every figure in the document should have a figure caption. As such, all figures in a document will be listed in a List of Figures,
which will follow the Table of Contents (and follow the List of Tables, if the document has Tables). The following is an example of a properly formatted figure, with the corresponding figure caption.

![Boise State University logo](image)

**Figure 1** This Is an Example Figure

**Figure Captions**

The figure caption should be centered and bolded, placed beneath the figure to which it refers. The figure caption should be title capped. All figure captions must match the figure captions listed in the List of Figures.

The numbering for the figure captions can vary. The numbering can be chronological or based on the chapter in which the figure is located, and the subsequent number of the figure in that chapter. For example, the second figure in the third chapter of a thesis/dissertation could be numbered as “Figure 3.2 Here Is the Example Figure Caption.”

The figure caption should occur on the same page as the figure.

**Figure Captions in Appendices**

Regardless of which number style is adopted for the figure captions in the rest of the document, figure captions in the appendices must be listed with the appropriate appendix indicator and the subsequent number of the figure. For example, the third figure
listed in Appendix B would be numbered as “Figure B.3 Here Is the Example Figure Caption.”

This numbering system clearly indicates the location of the figure in the document for the reader when the reader is viewing the List of Figures, or when a reference is made in the document to the respective figure.

Footnotes

Refer to the styles guide for your discipline for instructions on how to format the footnotes section of your document. If no prescribed method is indicated, please use the following guidelines.

The footnotes should appear on the same page as the citations to which the footnotes refer. A line should separate the document text on the page and the footnote text. A space should precede and follow the line separating the text and footnotes. The footnotes should be single-spaced, and double-spaced between each footnote.¹ For an example, see the bottom of this page.²

Tables

Tables should be aligned left. The table must consist of a clear and concise table header, which indicates what the reader should expect in the table and how the reader is

¹ This is an example of footnote text. This sentence will carry over to the next in a single-spaced fashion, and the example footnote will continue.

² This is an example footnote.
to read the table. The content in the table cells can be single spaced, rather than double spaced for readability and clarity.

Every table should have a table caption listed above it. See “Table Captions” below for instructions on what to include in your table captions.

If the table must flow over multiple pages, ensure the table header repeats at the top of each page to indicate clearly to the reader how each column should be read.

**Table Captions**

The table caption should be aligned left and bolded, placed above the table to which it refers. The table caption should be title-capped. All table captions must match the table captions listed in the List of Tables.

The numbering for the table captions can vary. The numbering can be chronological or based on the chapter in which the table is located and the subsequent number of the table in that chapter. For example, the second table in the third chapter of a thesis/dissertation could be numbered as “Table 3.2 Here Is the Example Table Caption.”

The table caption should appear on the same page as the table.

**Table Captions in Appendices**

Regardless of which number style is adopted for the table captions in the rest of the document, table captions in the appendices must be listed with the appropriate appendix indicator and the subsequent number of the table. For example, the third table listed in Appendix B would be numbers as “Table B.3 Here Is the Example Table Caption.”
This numbering system clearly indicates the location of the table in the document for the reader when the reader is viewing the List of Tables, or when a reference is made in the document to the respective table.

**Citation and Reference Standards and Guidelines**

The citation and reference standards and guidelines for your thesis/dissertation are heavily determined by your discipline and field. Please ensure the accuracy of your internal and external citations, and ensure you have properly created your References, Bibliography, or Works Cited listing. Listed below are some general guidelines for preparing your citations; consult your advisor and the styles guides per your discipline for detailed reference-preparation guidelines.

You are responsible for adhering to the most current citation and reference styles and guidelines required by your field.

*Note:* Any thesis/dissertation failing to meet basic standards and guidelines for citations, or failing to be accurate and diligent in referenced sources, may be rejected during Format Review.

**Bibliography vs. References vs. Works Cited**

The type of references list you use depends on two main factors: 1) your discipline, and 2) how you intend to list sources. For example, if you use regular internal citation in which a shortened citation is used to refer the reader to the full citation listed in the references list, then you would want to use a References list or a Works Cited; which is to say, you would want to use a listing that consists of all of the sources you referred to in the document body. However, if you are using footnotes throughout the document as the main means of providing full citation information, you might prefer to
use a selected Bibliography; this selected Bibliography could list additional sources you found helpful but didn’t cite directly in the document and could also contain detailed listings from the internal citation.

In general, the References and Works Cited are the preferred method as these two citation listings provide the reader with clear source references to which they can refer for further information or confirmation of the research completed for the thesis/dissertation.

Sometimes the Bibliography is not limited in the items cited; in these instances, the Bibliography functions the same way as a References list or a Works Cited. See the *Chicago Manual of Style* for a detailed description of the differences in Bibliography choices and detailed descriptions of the References and Works Cited.

**Internal Citation**

Some method of internal citation is required. Whichever method is used, the reader should clearly and easily be able to determine the referenced source, and in addition, should be able to easily identify the full citation in the References, Works Cited, or Bibliography (or the full citation listed in the footnotes, depending on the citation method).

Please follow the convention used by your discipline; see the styles guide recommended by your department and/or thesis/dissertation advisor.

If you document contains footnotes, please see the “Footnotes” section above for information about formatting the footnotes section in your document.
Multimedia Files

Occasionally, a student may desire to have supporting media files with their thesis/dissertation. These may include video or music files, or other supporting media. These media files are not in place of the thesis/dissertation nor are they directly a part of the work; they are in support of the work, which means they add value, but the thesis/dissertation can stand alone without the additional files, video, etc.

In these cases, a student may wish to include the supporting media with their final thesis/dissertation. The student must own the rights to the supporting files/documents. These files will be featured on ScholarWorks as a supporting file to the thesis/dissertation and will be included with the printed copies of your work as a CD.

If you wish to include the supporting media, when turning in your final copies to the Graduate College, turn in four CDs. Three CDs should contain a copy of the multimedia file(s); the fourth CD should contain both a copy of the thesis/dissertation and a copy of the multimedia file(s).

Each CD should be labeled with the student’s name and the name of the thesis/dissertation.
CHAPTER THREE: INSTRUCTIONS FOR USING THE GRADUATE TEMPLATE AND MICROSOFT WORD

Overview

Note: In order for your thesis, project, or dissertation to be uploaded correctly in the ETD system, the document must be in a single file. This single file can be a .DOC file, a .DOCX file, or a .PDF file.

For LaTeX specific information, please see the instructions provided by your department. Minor aspects of this guide may differ slightly from the LaTeX templates provided by your department.

The Graduate College now offers a thesis/dissertation template that contains all required content and formatting. You can either write your document from within the template or apply the template’s formatting to your previously created work.

The following instructions are divided by the ways in which you will approach the formatting of your document: using the template from the beginning, applying the template to a previously created document, or manually formatting without the use of the template. Note that even when using the template from the beginning, there may be certain formatting elements (such as the pagination of landscape pages) that need to be done manually.
Writing Your Document within the Template

The following instructions should be referenced if you decide to write your document within the template. This option requires the least amount of work from students. For instructions on creating bookmarks within a pdf, see the Manually Formatting Your Document section below.

Downloading the Template

Download the Boise State Thesis and Dissertation Template from the Forms section of the Graduate College website. After it downloads, right-click on the file and select New, which will open a new document based on the template. This document can be saved under any name and in any location you wish.

Replacing Content and Applying Styles

Replace the names, dates, and gendered pronouns on the Title page, Copyright page, and Electronic Approval page with your information. Replace the template content with your own work.

IMPORTANT: When entering your own work into the template, be sure to apply the following styles to the appropriate parts of your document. Failure to do so will mean that your Table of Contents, List of Figures, and List of Tables will be incorrect.

- Heading 1
- Heading 2
- Heading 3
- Figure Caption
These styles can be found by clicking the arrow in the lower right hand corner of the Styles section in the Home tab. To apply a style, simply highlight the text that you wish to format and click the appropriate name from the styles list.

**Formatting Landscape Pages**

When setting pages of your document to landscape orientation to accommodate large figures or tables, you must reformat their page numbers so that they will still be visible after binding.

1. Open the landscape page’s header by double-clicking within the header.
2. Deselect Link to Previous, located in the Navigation section of the Design tab. Repeat this step for the page following the landscape page.
3. Delete the landscape page’s current page number.
5. Select Landscape Page Numbers.

*Note: If your other pages’ pagination disappears after inserting landscape page numbers, you likely did not turn off Link to Previous. Undo your changes to the page numbers and restart the instructions.*

**Replacing Table of Contents, List of Figures, and List of Tables**

After your writing and editing is complete, you will need to replace the Table of Contents, List of Figures, and List of Tables.

1. Right click the existing TOC, LOF, or LOT.
2. Click Update Field.

3. Select Update entire table and click Ok.

Note: All other lists (such as a List of Abbreviations or List of Graphs) are not automatically-updateable. Instead, the template includes examples of manually-created lists that can be altered to fit your needs.

Attaching the Template to a Preexisting Document

If your document is at or near completion, it may be easier for you to attach the template to your existing file than to paste your document into the new template.

Formatting Styles

Before attaching the Thesis/Dissertation template to your document, you must first apply the following styles to the appropriate sections of your work. It does not matter how these styles look, only that the names of the styles match those in the following list exactly.

<table>
<thead>
<tr>
<th>Table 3.1</th>
<th>Word Styles and the Sections to Which They Should Be Applied</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Style Name</strong></td>
<td><strong>Text to which you should apply the style</strong></td>
</tr>
<tr>
<td>Appendix Heading 2*</td>
<td>All Heading 2s in the appendices EXCEPT the subtitle listed on each appendix’s title page</td>
</tr>
<tr>
<td>Appendix Heading 3*</td>
<td>All Heading 3s in the appendices</td>
</tr>
<tr>
<td>Approval Page*</td>
<td>All content on the approval page (you may need to adjust alignment and text size after applying this style)</td>
</tr>
<tr>
<td>Copyright Page*</td>
<td>All content on the copyright page</td>
</tr>
<tr>
<td>Figure Caption*</td>
<td>All figure captions</td>
</tr>
<tr>
<td>Heading 1</td>
<td>• Chapter and Appendix titles</td>
</tr>
</tbody>
</table>
- Titles for all front matter pages **except**
  - Title page
  - Copyright page
  - Approval pages
  - Table of Contents

<table>
<thead>
<tr>
<th>Heading 2</th>
<th>All Heading 2s, including Appendixes’ subtitles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heading 3</td>
<td>All Heading 3s</td>
</tr>
<tr>
<td>Table Caption*</td>
<td>All table captions</td>
</tr>
<tr>
<td>Table of Contents*</td>
<td>The Table of Contents page’s title ONLY</td>
</tr>
<tr>
<td>Title of Document*</td>
<td>ONLY the title of your thesis/dissertation</td>
</tr>
<tr>
<td>Title Page*</td>
<td>All content on the title page other than the work’s title</td>
</tr>
</tbody>
</table>

*These styles will not exist in your original document and thus will have to be created. See instructions below.

**Attaching Styles**

1. Highlight the text you wish to format

2. Click the appropriate style from the row of them in the Styles section of the Home tab.

*Note: If the style you are looking for is not included in the row of styles, click the arrow in the lower right-hand corner of the styles section for a full list of styles.*

**Creating Styles**

Some required styles will not be listed in the premade styles, thus you will need to create them yourself.

1. Highlight the text that you wish to format

2. Right click the text and select Styles ➔ Save selection as a New Quick Style.
3. Enter the appropriate style name and click Ok.

*Note: Remember, it does not matter how these styles look, only that the style names match the names listed above.*

**Attaching the Template**

After applying styles to your document, you can attach the template, which will fix most of your document’s formatting issues.

1. Download the template from the Forms section of the Graduate College’s website, making sure to note the location in which you save it.

2. Open the Word document containing your thesis/dissertation, click the Developer tab, and select Document Template.

3. In the Document Template section, click Attach.

4. Navigate to the folder in which you saved the template and select it.

5. Click Ok.

6. IMPORTANT: Check the box labeled “Automatically update document styles.”

7. Click Ok.

*Note: If the Developer tab is not visible, follow the following instructions:*

- **Word 2007:** Click the Office Button ➔ Word Options ➔ Popular ➔ Show Developer tab in the Ribbon ➔ Ok

- **Word 2010:**
  1. Click the File tab ➔ Options ➔ Customize Ribbon ➔
  2. Select Developer from the list of options and click Add.
  3. Click OK to close the Options dialog box.
Adjusting Margins

1. Place the cursor at the beginning of your document.

2. Click on the Macros button

   - Word 2007: Located in the Code section of the Developer tab (if the Developer tab is not visible, click Office Button → Word Options → Popular → Show Developer tab in the Ribbon → Ok)

   - Word 2010: Located in the Macros section of the View tab

3. Select Margins and click Run.

   Note: Sometimes section breaks (such as between front matter and body text or before landscape-oriented pages) interfere with the macro’s command. If so, place the cursor somewhere on the unaffected page, and repeat steps 2-3.

Setting Page Numbers

Be careful that you set section breaks between front matter and body text and also between portrait and landscape-oriented pages (see Manually Formatting Your Document for instructions on setting page breaks). Each has a different way of formatting their pagination.

Front Matter

1. Set a continuous section break immediately before the Heading 1 on the first page that follows your approval pages.

2. Set a continuous section break immediately before the title of Chapter 1.
3. Open the footer on the first page following your signed approval pages by clicking the Footer button in the Header & Footer section of the Insert tab and selecting Edit Footer.

4. Deselect Link to Previous, located in the Navigation section of the Design tab. This step is only necessary for the first numbered page in the front matter.

5. Insert page numbers. Front matter page numbers should be in lowercase Roman numerals and should be centered at the bottom of each page.

   **Body Text**

1. Double-click inside the footer of the first page in Chapter 1.

2. Deselect Link to Previous, located in the Navigation section of the Design tab. This step is only necessary for the first page in the body text.

3. Delete the page numbers from the footer.

4. Open the header on the same page by double-clicking inside the header.

5. Deselect Link to Previous, located in the Navigation section of the Design tab.

6. Insert alpha-numeric page numbers, starting with 1, into the upper right-hand corner of the pages.

   **Landscape Pages**

When setting pages of your document to landscape orientation to accommodate large figures or tables, you must reformat their page numbers so that they will still be visible after binding.
1. Open the landscape page’s header by double-clicking within the header.
2. Deselect Link to Previous, located in the Navigation section of the Design tab.
3. Repeat step 3 on the page following the landscape page.
4. Delete the landscape page’s current page number.
5. Click Insert ➔ Page Number (in the Header & Footer section) ➔ Page Margins.

Note: If your other pages’ pagination disappears after inserting landscape page numbers, you likely did not turn off Link to Previous. Undo your changes to the page numbers and restart the instructions.

Inserting Table of Contents and Lists of Figures or Tables

Finally, after your document’s content is complete, you will need to create the Table of Contents, List of Figures, and List of Tables.

1. Place the cursor on the first line of text after the Heading 1 of the section you are about to create.
2. Click on the Macros button
   - Word 2007: Located in the Code section of the Developer tab (if the Developer tab is not visible, click Office Button ➔ Word Options ➔ Popular ➔ Show Developer tab in the Ribbon ➔ Ok)
   - Word 2010: Located in the Macros section of the View tab
3. Select the appropriate macro (each macro contains a description of its function) and click Run.

Note: The template does not include macros for automatically generating other lists such as a List of Abbreviations or List of Graphs. However, it does include example lists that can be copied, pasted, and altered to meet your needs.
Manually Formatting Your Document

If you do not wish to use the template, you can still manually format your document. Below are basic instructions you may find useful while formatting your document. Please note that all Microsoft Word instructions are for Word 2007 or 2010.

Creating a Single File from Multiple Files Using Microsoft Word

*Note:* If you want to insert the header and footer also, be sure to insert the text from the file in a new section so that the header and footer are applied to only those pages.

In Word 2007 and 2010, the Insert File command has been renamed Text from File and moved to the Object menu on the Insert tab. Insert text from another file by doing the following:

1. Place your cursor at the point where you wish to insert the text.
2. On the Insert tab, in the Text group, click the arrow next to Object, and then click Text from File.
3. In the Insert File dialog box, locate the file you want to add and double-click it.

Setting Section Breaks in Microsoft Word

Section breaks allow you to format sections of your document independently from other sections. They are necessary when formatting page numbers and including both landscape and portrait-oriented pages.
1. Place the cursor at the point in your document where you wish to change your page formatting.

2. Click the Page Layout tab on the ribbon.

3. In the Page Setup section, click the Breaks icon.

4. Select Continuous. This creates a section break between the current and previous pages that will allow you to change the formatting in one section without affecting the other.

**Formatting Page Numbers in Microsoft Word**

Be careful that you set section breaks between front matter and body text and also between portrait and landscape-oriented pages. Each has a different way of formatting their pagination.

**Front Matter**

1. Set a continuous section break immediately before the Heading 1 on the first page following your approval pages.

2. Set a continuous section break immediately before the title of Chapter 1.

3. Open the footer on the first page following your signed approval pages by clicking the Footer button in the Header & Footer section of the Insert tab and selecting Edit Footer.
4. Deselect Link to Previous, located in the Navigation section of the Design tab.
   This step is only necessary for the first numbered page in the front matter.

5. Insert page numbers. Front matter page numbers should be in lowercase Roman numerals and should be centered at the bottom of each page.

Body Text

1. Open the footer of the first page in Chapter 1 of your document by clicking the Footer button in the Header & Footer section of the Insert tab and selecting Edit Footer.

2. Deselect Link to Previous, located in the Navigation section of the Design tab.
   This step is only necessary for the first numbered page in the body text.

3. Delete the page numbers from the footer.

4. Open the header on the same page by clicking the Header button in the Header & Footer section of the Insert tab and selecting Edit Header.

5. Deselect Link to Previous, located in the Navigation section of the Design ribbon.

6. Insert alpha-numeric page numbers, starting with 1, into the upper right-hand corner of the pages.
Landscape Pages

When setting pages of your document to landscape orientation to accommodate large figures or tables, you must reformat their page numbers so that they will still be visible after binding.

1. Set section breaks to divide the landscape page from the other pages.
2. Open the landscape page’s header by page by double-clicking within the header.
3. Deselect Link to Previous, located in the Navigation section of the Design tab. You will need to repeat this step for the page following the landscape page.
4. Delete the current page number.
5. In the Header & Footer section, located under the ribbon’s Insert tab, click Page Number.
6. Place the cursor over Page Margins and when the option window appears, select Vertical, Right.
7. Highlight the text and format to match your body text’s size and font.
8. Right-align text and delete the word “Page.”
9. Click the Format tab on the ribbon.
10. In the Text section, click the Text Direction button twice (if using 2007). If using 2010, click the Text Direction button once and select Rotate all text 90°.

Creating Dot Leaders for Manual Table of Contents in Microsoft Word

1. Click Home. In the bottom-right corner of the Paragraph field there is an arrow button; click this arrow button. The Paragraph window will open.

2. Click the Tabs button. The Tabs window will open.

3. Type in the Tab Stop Position as 0.5.

4. Select Alignment/Left.

5. Select Leader/#1 None.
6. Select Set.

7. Type in Tab Stop Position as 1.0.

8. Select Alignment/Left.

9. Select Leader/#1 None.

10. Select Set.

11. Type in Tab Stop Position as 5.63.

12. Select Alignment/Left.


14. Select Set.

15. Type in Tab Stop Position as 5.89.

16. Select Alignment/Right.

17. Select Leader/#1 None.

18. Select Set.

19. Select OK.

20. In the document, type the heading title, hit space bar twice, press Tab twice, then type in the page number.

Generating an Automatic Table of Contents Using Styles in Microsoft Word

To create an automatic table of contents, you will first have to modify and apply styles to your headings.
Modifying Styles

1. Click the arrow in the lower right-hand corner of the styles section, located in the ribbon’s Home tab. A pop-out window will appear.
2. Right-click the Heading 1 option and select Modify.
3. Format the style to match the heading requirements listed in the “General Formatting Guidelines.” Additional font controls can be found by clicking the Format button in the window’s lower left-hand corner. Once your changes have been made, click Ok.
4. Repeat steps 1-4 for Headings 2 and 3.

Note: Heading 3 may not initially appear in the pop-out window’s list of styles. If this is the case, click the Options button and in the Select Styles to Show field, choose All Styles.

Applying Styles

The benefit to using styles is that you do not have to reformat every heading individually. Once the styles are created, all you have to do to format your text is the following:

1. Highlight a heading from your text.
2. Click on the appropriate style that you previously modified. The style will be applied instantly.

Generating an Automatic Table of Contents

After applying styles to every Heading 1, 2, and 3, you can create an automatic table of contents. Automatic TOC’s are easily updateable at any time by right-clicking and selecting Update Field.

1. Place the cursor at the point in your document where you wish to insert a Table of Contents.
2. Click on the References tab on the ribbon.
3. Click the Table of Contents button and select Insert Table of Contents. A new window will appear.
4. Click the Modify button. A pop-out window will appear.
5. Click Modify.
6. Adjust the TOC Style to match the normal body text formatting as listed in the “General Formatting Guidelines” in Chapter 2.
7. Click Ok.
8. Manually delete the title page, copyright page, approval pages, and the table of contents page from the TOC.

Note: Heading 1s will not appear in all caps in the TOC unless you manually type them out in all caps in the document.

Creating Bookmarks for Your PDF Files in Microsoft Word

Bookmarks allow readers to easily navigate through your document. In order to create them in Word, you must have applied Styles to your headings (instructions listed above).

2007

1. Click the Office button in the upper left-hand corner of the screen.
2. Place the cursor over Save As and select the pdf option.
3. Click the Options button.
4. Under the Include non-printing information section, check the box named Create bookmarks using.
5. Make sure that the Headings option is selected and click Ok.
6. Save the file.

2010

1. Click the File Tab
2. Click Save As
3. Select PDF from the Select File Type drop-down menu.
4. Continue with steps 3-5 of the 2007 instructions.

Note: When saving the file in Word 2010, in the Optimize for section, select the Minimum size (publishing online) option. This creates a smaller file and
allows your document to load more quickly when readers open it on ScholarWorks.

Creating a Single File from Multiple Files Using Acrobat Adobe Professional

In Adobe Acrobat Pro, merge files into a single PDF by clicking File, Create PDF, then Merge Files into a Single PDF.
<http://www.niso.org/kst/reports/standards?step=2&gid=None&project_key%3Austring%3Aiso-8859-1=5944461cb4a1e365ad1688ec6f6c199c9d90ee71>.


APPENDIX A

Example Pages
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Example</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example Title Page</td>
<td>71</td>
</tr>
<tr>
<td>Example Copyright Page</td>
<td>72</td>
</tr>
<tr>
<td>Example Creative Commons Page</td>
<td>73</td>
</tr>
<tr>
<td>Example Thesis Defense Committee Approval Page</td>
<td>74</td>
</tr>
<tr>
<td>Example Thesis Final Reading Approval Page</td>
<td>75</td>
</tr>
<tr>
<td>Example Electronic Thesis Defense and Final Reading Approval Page</td>
<td>76</td>
</tr>
<tr>
<td>Example Abstract</td>
<td>77</td>
</tr>
<tr>
<td>Example of a Different Style Abstract</td>
<td>78</td>
</tr>
<tr>
<td>Example Table of Contents</td>
<td>79</td>
</tr>
<tr>
<td>Example List of Tables</td>
<td>80</td>
</tr>
<tr>
<td>Example List of Figures</td>
<td>81</td>
</tr>
<tr>
<td>Example Chapter with Example Headings</td>
<td>82</td>
</tr>
<tr>
<td>Example Works Cited List (MLA)</td>
<td>83</td>
</tr>
</tbody>
</table>
THE INFINITE QUANDRY OF MITOCHONDRIA FIXATION:
THE STORY OF DALLAS MAGEE

by

Name of Writer

A thesis
submitted in partial fulfillment
of the requirements for the degree of
Master of Fine Arts in Creative Writing
Boise State University

May 2010
Stephanie Stacy Starr

SOME RIGHTS RESERVED

This work is licensed under the Creative Commons Attribution-NonCommercial-NoDerivs 3.0 United States license. To view a copy of this license, visit http://creativecommons.org/licenses/by-nc-nd/3.0/us/ or send a letter to Creative Commons, 171 Second Street, Suite 300, San Francisco, California 94105, USA.
DEFENSE COMMITTEE AND FINAL READING APPROVALS

of the thesis submitted by

Stephanie Stacey Starr

Thesis Title: The Effect of Alien Spaceship Engines on the Thermal Convection of the Atmosphere During the Quaternary Period

Date of Final Oral Examination: 01 April 2009

The following individuals read and discussed the thesis submitted by student Stephanie Stacey Starr, and they evaluated her presentation and response to questions during the final oral examination. They found that the student passed the final oral examination.

Marie S. Curie, Ph.D. Chair, Supervisory Committee

H. Rudolf Hertz, Ph.D. Member, Supervisory Committee

James Clerk Maxwell, Ph.D. Member, Supervisory Committee

The final reading approval of the thesis was granted by Marie S. Curie, Ph.D., Chair of the Supervisory Committee. The thesis was approved for the Graduate College by John R. Pelton, Ph.D., Dean of the Graduate College.
ABSTRACT

This is an example sentence. This is another example sentence that follows the sentence before this one. This is another example sentence. Another sentence will follow, which will also be an example, demonstrating what another sample sentence could look like. Here is another example sentence.

This is an example sentence. This is another example sentence that follows the sentence before this one. This is another example sentence. Another sentence will follow, which will also be an example, demonstrating what another sample sentence could look like. Here is another example sentence.
ABSTRACT

The Effect of Alien Spaceship Engines on the Thermal Convection of the Atmosphere During the Quaternary Period

Stephanie Stacey Starr

This is an example sentence. This is another example sentence that follows the sentence before this one. This is another example sentence. Another sentence will follow, which will also be an example, demonstrating what another sample sentence could look like. Here is another example sentence.

This is an example sentence. This is another example sentence that follows the sentence before this one. This is another example sentence. Another sentence will follow, which will also be an example, demonstrating what another sample sentence could look like. Here is another example sentence.
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABSTRACT</td>
<td>iii</td>
</tr>
<tr>
<td>LIST OF TABLES</td>
<td>vi</td>
</tr>
<tr>
<td>LIST OF FIGURES</td>
<td>vii</td>
</tr>
<tr>
<td>LIST OF ABBREVIATIONS</td>
<td>ix</td>
</tr>
<tr>
<td>CHAPTER ONE: HE SPOKE IN LONG SENTENCES</td>
<td>1</td>
</tr>
<tr>
<td>Introduction</td>
<td>1</td>
</tr>
<tr>
<td>The Way of the World</td>
<td>3</td>
</tr>
<tr>
<td>The Upward Stance of Dallas Magee</td>
<td>5</td>
</tr>
<tr>
<td>The Sideways Stare of Dallas Magee</td>
<td>7</td>
</tr>
<tr>
<td>The Downward Spiral of Dallas Magee</td>
<td>11</td>
</tr>
<tr>
<td>The Other Side of the World</td>
<td>15</td>
</tr>
<tr>
<td>Here He Comes Again: The Long Drive Home</td>
<td>18</td>
</tr>
<tr>
<td>CHAPTER TWO: HE DRANK THE SKY</td>
<td>27</td>
</tr>
<tr>
<td>Over the Malice Tree</td>
<td>38</td>
</tr>
<tr>
<td>What Long Teeth You Have: The Critical Response to Magee</td>
<td>42</td>
</tr>
<tr>
<td>The Post-Modern Approach</td>
<td>47</td>
</tr>
<tr>
<td>The Pre-Post-Modern Approach</td>
<td>52</td>
</tr>
</tbody>
</table>
CHAPTER THREE: CONCLUSIONS .......................................................... 62

WORKS CITED .................................................................................. 75
LIST OF TABLES

Table 1.1  Summary of environmental and body condition variables explored as they relate to migratory orientation and restlessness in Flammulated Owls and Northern Saw-whet Owls .......................... 45

Table 1.2  Results of a negative binomial generalized linear model describing the relationship between migratory restlessness in Northern Saw-whet Owls and a variety of environmental and body condition variables ................................................................. 47

Table 1.3  ETC. ........................................................................................................................................... 52
LIST OF FIGURES

Figure 1.  This Is the Figure Caption for Figure 1 ........................................ 4

Figure 2.  This Is the Figure Caption for Figure 2 ........................................ 12

Figure 3.  This Is the Figure Caption for Figure 3 ........................................ 14
CHAPTER ONE: CHAPTER HEADING 1 HEADING

Heading 2

Heading 3

Heading 4

Heading 5. The paragraph keeps going from this same line.
WORKS CITED


APPENDIX B

Common Mistakes Observed During Format Review

and Editing Marks Used on Format Review
Common Mistakes Observed During Format Review

- Headings, Figure Captions, Table Captions, etc do not match those items listed in the Table of Contents, the List of Figures, the List of Tables, etc.

- Incorrect student name: Name must match the student’s primary name in My.BoiseState.

- Incorrect degree title: Must be the same as title in catalogue

- Incorrect graduation date: Should be one of three choices plus the graduation year: December, May, or August. Do not list season.

Reasons a Document May Be Rejected During Format Review

- The standards and guidelines for thesis/dissertation formatting are not followed

- Citations are incorrect beyond what is reasonable

Reasons a Document May Be Returned After Final Copy Submission

- Incorrect Defense Committee Approval Pages or Final Reading Approval Pages; errors on these pages, or printed on incorrect paper: there must be 3 official copies of each of these signed forms printed on 25% cotton paper.

- Incorrect student name listed

- Incorrect degree title listed

- Incorrect font and font size

- Incorrect paper type

- Poor printed or electronic copy
Editing Marks Used by the Thesis/Dissertation Coordinator on Review Copies

See the following pages for examples of common editing marks and their definitions.
APPENDIX C

Final Copies Checklists for Theses and Dissertations
Final Copies Checklist for Theses and Dissertations

After Comments and Edits Are Incorporated from Format Review

☐ Re-insert table of contents, list of tables, and list of figures in Front Matter (if using Word) to ensure all changes are taken into account.

☐ Double-check the page numbers on the Table of Contents, List of Figures, and List of Tables to ensure each page number listed matches the respective chapter headings, subheadings, figure number/caption, and table number/captions.

Ensure formatting is consistent throughout.

☐ Proofread the document before printing final copies.

Note: It is highly recommended that you print a copy of your document on regular paper to verify everything prints accurately, and all elements of the document are in order, before printing all of the final copies on 25% cotton paper.

Next Steps for Preparing Final Thesis/Dissertation Submission Packet

Basic Instructions:

☐ Print three (3) official copies of your thesis/dissertation on 25% cotton paper (100% cotton paper may be used but is more expensive); recycled paper is unacceptable.

☐ Include a blank piece of 25% cotton paper before the title page and after the last page of your thesis/dissertation for each copy made. This is a total of six (6) pages of blank 25% cotton paper.
Save an electronic copy of the thesis to a rewriteable CD. Ensure the saved electronic copy of the thesis is contained in a single file and that the electronic version contains the electronic approval page. (See Chapter 3 of the *Standards and Guidelines for Theses and Dissertations* for instructions on creating a single file and burning an electronic copy to CD. See Chapter 2 for information regarding the electronic approval page.)

Include a check to Boise State University for $20 for the cost of the binding fee associated with the library circulation copy and departmental copy of your thesis/dissertation. (See Chapter 1 of the *Standards and Guidelines for Theses and Dissertations* for additional information regarding fees.)

Ensure the required forms are included with the Final Thesis/Dissertation Submission packet. (See below for details regarding required forms.)

Send the packet to the Graduate College at the following address (postmarked) by the final copy deadline listed on the Academic Calendar for the anticipated graduation semester, or simply bring the final copies to the Graduate College by the date specified:

Jodi Chilson

Graduate College, MS-1110

Boise State University

1910 University Drive

Boise, Idaho  83725
Required Forms to Include with Final Thesis/Dissertation Submission Packet:

☐ Graduate College Access Agreement for Thesis or Dissertation Form (which must be signed by your advisor prior to your submission of the document to the Graduate College).

☐ Approval Pages (the Defense Approval pages and Final Reading Approval pages not already delivered to the Graduate College).

☐ Submission of Culminating Activity and Binding Request Form (which is obtained in the Graduate College when submitting your final copies).

☐ **For Ph.D. Dissertation Only**—Survey of Earned Doctorates (SED).
APPENDIX D

Sample Permissions Letters
Sample Permission Letter for Contributing Authors of Article

Name
Address
Phone

Date:

Dear ____________:

I am writing to request permission to use the article “[article title],” which was published in Journal Name, volume X(N), on [date], for which you were a contributing author, in my thesis/dissertation.

I will include acknowledgements and/or appropriate citations to the work and copyright and reprint rights in the appendices. The bibliographic citation will appear in the References list at the end of the manuscript as typed below. Please advise me of any changes your require.

Please indicate your approval of this request by signing in the space provided, attaching any forms or instructions necessary to confirm permission. If you charge a reprint fee for use of your material, please indicate that as well. If you have questions, please call me at the number above.

I hope you will be able to reply immediately. If you are not the copyright holder, please forward my request to the appropriate person or institution.

Thank you for your cooperation,

[your name]

I hereby give permission to [your name] to reprint the following material in his/her thesis/dissertation.

(Description: Full bibliographic information, including specific page numbers and specifications [table numbers, figure numbers, direct quotations of lines, etc.].)

Signed: _________________________________________________________

Date: ________________
Sample Permission Letter: Request to Use Someone Else’s Work

Name
Address
Phone

Date:

Dear ____________:

I am currently completing my thesis/dissertation in the [name of department] at Boise State University. I hope to complete in the [fall, spring, summer] of [year].

I am writing to request permission to use the material acknowledged below in my thesis/dissertation.

I will include acknowledgements and/or appropriate citations to the work and copyright and reprint rights in the appendices. The bibliographic citation will appear in the References list at the end of the manuscript/chapter as typed below. Please advise me of any changes your require.

Please indicate your approval of this request by signing in the space provided, attaching any forms or instructions necessary to confirm permission. If you charge a reprint fee for use of your material, please indicate that as well. If you have questions, please call me at the number above.

I hope you will be able to reply immediately. If you are not the copyright holder, please forward my request to the appropriate person or institution.

Thank you for your cooperation,

[your name]

I hereby give permission to [your name] to reprint the following material in his/her thesis/dissertation.

(Description: Full bibliographic information, including specific page numbers and specifications [table numbers, figure numbers, direct quotations of lines, etc.].)

Fee

Signed: ________________________________

Date: _______________
Sample Permission Letter to Request Journal Copyright Release

Name
Address
Phone

Date:

Dear _____________:

I am currently completing my thesis/dissertation in the [name of department] at Boise State University. I hope to complete in the [fall, spring, summer] of [year].

An article, [title of article], of which I am the first author, and which appeared in your journal ([date of publication, volume, page numbers]) reports an essential part of my thesis/dissertation research. I would like permission to reprint it as a chapter in my thesis/dissertation. (Reprinting the chapter may necessitate some revision.) Please note that Boise State University uploads an electronic version of the thesis/dissertation in an institution repository called ScholarWorks.

I will include an acknowledgement to the article on the first page of the chapter, as shown below. Copyright and permission information will be included in the appendices. If you would like a different acknowledgement, please so indicate.

Please indicate your approval of this request by signing in the space provided, and attach any other form necessary to confirm permission. If you charge for a reprint fee for use of an article by the author, please indicate that as well.

If you have questions, please call me at the number above or send me an e-mail message at the above address. Thank you for your assistance.

Best Regards,

[your name]

I hereby give permission to _______[your name]__________ to reprint the requested article in his/her thesis/dissertation, with the following acknowledgement:

(Acknowledgement, including full bibliographical information, including title, journal, volume, date, and page numbers.)

Signed: ____________________________

Date: ________________

Fee: ________________
INDEX

Abbreviations
  List of ........................................ 56, 61
  APA ........................................... See Citations

Abstract .................................. 4, 12, 21, 39
  Example .................................... 77–78

Access Agreement
  Dissertation .................................. 19
  Thesis .......................................... 10

Acknowledgements.......................... 38

Alignment
  Block quotes .................................. 45
  Figure captions ................................. 48

Figures .......................................... 48

Headings ........................................ 43

Table captions ................................. 50

Tables .......................................... 50

Text ............................................. 44

Appendix ....................................... 41
  Example ....................................... 69

Page numbers ..................... See Page Numbers

Styles .......................................... 57

Approval Pages
  Defense formatting ......................... 36

Dissertation defense .................... 14, 18

Dissertation electronic ....................... 19

Dissertation final reading .................. 14, 19

Electronic copy formatting ............... 29

Examples ...................................... 74–76

Final reading formatting .................. 37

Styles .......................................... 57

Thesis defense .............................. 5, 9
<table>
<thead>
<tr>
<th>Section</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thesis electronic</td>
<td>9</td>
</tr>
<tr>
<td>Thesis final reading</td>
<td>5, 9</td>
</tr>
<tr>
<td>Audio Files</td>
<td>See Multimedia</td>
</tr>
<tr>
<td>Autobiographical Information</td>
<td>38</td>
</tr>
<tr>
<td>Bibliography</td>
<td>See Citations</td>
</tr>
<tr>
<td>Block Quotes</td>
<td>44</td>
</tr>
<tr>
<td>Bookmarks</td>
<td>66–67</td>
</tr>
<tr>
<td>Bullet Lists</td>
<td>45</td>
</tr>
<tr>
<td>Captions</td>
<td></td>
</tr>
<tr>
<td>Figure</td>
<td>48</td>
</tr>
<tr>
<td>Figure in appendix</td>
<td>49</td>
</tr>
<tr>
<td>Styles</td>
<td>57</td>
</tr>
<tr>
<td>Table</td>
<td>50</td>
</tr>
<tr>
<td>Table in appendix</td>
<td>50</td>
</tr>
<tr>
<td>CD</td>
<td>See Electronic Copy</td>
</tr>
<tr>
<td>Supporting Material</td>
<td>See Multimedia</td>
</tr>
<tr>
<td>Chicago Style</td>
<td>See Citations</td>
</tr>
<tr>
<td>Citations</td>
<td>40, 51</td>
</tr>
<tr>
<td>Example</td>
<td>83</td>
</tr>
<tr>
<td>Footnotes</td>
<td>See Footnotes</td>
</tr>
<tr>
<td>Internal</td>
<td>52</td>
</tr>
<tr>
<td>Type of reference list</td>
<td>51</td>
</tr>
<tr>
<td>Contact Information</td>
<td>iii, 90</td>
</tr>
<tr>
<td>Copyright</td>
<td>33–34</td>
</tr>
<tr>
<td>Creative Commons</td>
<td>35, 73</td>
</tr>
<tr>
<td>Example</td>
<td>72</td>
</tr>
<tr>
<td>Styles</td>
<td>57</td>
</tr>
<tr>
<td>Creative Commons</td>
<td>35</td>
</tr>
<tr>
<td>Example</td>
<td>73</td>
</tr>
<tr>
<td>Cross-Reference</td>
<td>46</td>
</tr>
<tr>
<td>Deadlines</td>
<td>21–24</td>
</tr>
<tr>
<td>Dedication</td>
<td>28</td>
</tr>
<tr>
<td>Defense</td>
<td></td>
</tr>
<tr>
<td>Approval pages</td>
<td>36</td>
</tr>
<tr>
<td>Dissertation committee review copy</td>
<td>13</td>
</tr>
<tr>
<td>Dissertation process</td>
<td>13</td>
</tr>
<tr>
<td>Electronic approval page</td>
<td>29, 76</td>
</tr>
<tr>
<td>Example page</td>
<td>74</td>
</tr>
</tbody>
</table>
Thesis committee review copy........... 4
Thesis forms.............................. 9
Thesis process............................ 4
Dissertation
Format review ......................... 15–16
Dissertation Coordinator .............. 15, 17
Address ................................... 90
Contact information ..................... iii
Double-space ......................... See Spacing
Electronic Copy ......................... 20, 29
Dissertation ......................... 16, 19
Thesis ..................................... 7, 9
External Examiner ....................... 12
Figures ..................................... 48
Caption in Appendix ......... See Captions
Captions ................................. See Captions
List of .................. See List of Figures
Final Copies
Dissertation ......................... 16–18
Thesis ..................................... 7–8
Final Reading
Approval pages ....................... 37–38
Dissertation process ..................... 14–15
Example page ......................... 75
Thesis process ......................... 5
Font ..................................... 44
Footnotes .................................. 49, 52
Format Review
Dissertation ......................... 15–16
Thesis ..................................... 6–7
Formatting ...................................... 27
Alignment ......................... See Alignment
Block quotes .............................. 44
Bullet lists .............................. 45
Citations ................................. See Citations
Cross-references ....................... 46
Defense approval pages ............. 36
Figure captions ....................... 48
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Figures</td>
<td>48</td>
<td>With attached template</td>
</tr>
<tr>
<td>Final approval pages</td>
<td>37</td>
<td>Forms</td>
</tr>
<tr>
<td>Font</td>
<td>44</td>
<td>Deadlines</td>
</tr>
<tr>
<td>Footnotes</td>
<td>49</td>
<td>Required dissertation forms</td>
</tr>
<tr>
<td>General guidelines</td>
<td>41–44</td>
<td>Required thesis forms</td>
</tr>
<tr>
<td>Headings</td>
<td>43</td>
<td>Graphs</td>
</tr>
<tr>
<td>In template</td>
<td></td>
<td>See Template</td>
</tr>
<tr>
<td>Margins</td>
<td>42</td>
<td>Headings</td>
</tr>
<tr>
<td>Microsoft Word instructions</td>
<td>61</td>
<td>Creating bookmarks</td>
</tr>
<tr>
<td>Notes</td>
<td>47</td>
<td>Example page</td>
</tr>
<tr>
<td>Number lists</td>
<td>47</td>
<td>Styles</td>
</tr>
<tr>
<td>Page numbers</td>
<td>42</td>
<td>To include in table of contents</td>
</tr>
<tr>
<td>Paragraph</td>
<td>44</td>
<td>Images</td>
</tr>
<tr>
<td>References</td>
<td></td>
<td>See Figures</td>
</tr>
<tr>
<td>Spacing</td>
<td></td>
<td>Justified Alignment</td>
</tr>
<tr>
<td>References</td>
<td></td>
<td>See Citations</td>
</tr>
<tr>
<td>Spacing</td>
<td></td>
<td>See Spacing</td>
</tr>
<tr>
<td>Styles</td>
<td>57</td>
<td>Keywords</td>
</tr>
<tr>
<td>Table captions</td>
<td>50</td>
<td>Left-Alignment</td>
</tr>
<tr>
<td>Tables</td>
<td>50</td>
<td>Library Services</td>
</tr>
<tr>
<td>Title page</td>
<td>29–33</td>
<td>List of Figures</td>
</tr>
<tr>
<td>Section</td>
<td>Page(s)</td>
<td></td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>---------</td>
<td></td>
</tr>
<tr>
<td>Example</td>
<td>81</td>
<td></td>
</tr>
<tr>
<td>Inserting automatically with template</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>Replacing in template</td>
<td>56</td>
<td></td>
</tr>
<tr>
<td>List of Graphs</td>
<td>56, 61</td>
<td></td>
</tr>
<tr>
<td>List of Maps</td>
<td>56, 61</td>
<td></td>
</tr>
<tr>
<td>List of Photos</td>
<td>56, 61</td>
<td></td>
</tr>
<tr>
<td>List of Pictures</td>
<td>56, 61</td>
<td></td>
</tr>
<tr>
<td>List of Plates</td>
<td>56, 61</td>
<td></td>
</tr>
<tr>
<td>List of Symbols</td>
<td>56, 61</td>
<td></td>
</tr>
<tr>
<td>List of Tables</td>
<td>40</td>
<td></td>
</tr>
<tr>
<td>Example</td>
<td>80</td>
<td></td>
</tr>
<tr>
<td>Inserting automatically with template</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>Replacing in template</td>
<td>56</td>
<td></td>
</tr>
<tr>
<td>Maps</td>
<td>56, 61</td>
<td></td>
</tr>
<tr>
<td>List of</td>
<td>56, 61</td>
<td></td>
</tr>
<tr>
<td>Margins</td>
<td>42</td>
<td></td>
</tr>
<tr>
<td>Adjusting with attached template</td>
<td>59</td>
<td></td>
</tr>
<tr>
<td>Manually formatting landscape pages</td>
<td>56, 60, 63</td>
<td></td>
</tr>
<tr>
<td>Microsoft Word</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Creating a single file from multiple PDFs .............................................. 67
Creating bookmarks .............................................. 66–67
Photos
List of ........................................... 56, 61
Pictures ........................................ See Figures
List of ........................................... 56, 61
Plates ........................................ See Figures
List of ........................................... 56, 61
ProQuest .............................................. 1, 18
Quotes
Block ........................................ See Block Quotes
References ........................................ See Citations
Requirements
Dissertation .............................................. 10, 18–20
Elements of document .............................................. 28
Thesis .............................................. 2, 9–10
Right-Alignment ............... See Alignment
ScholarWorks .............................................. 20

Access agreement form ............... 10, 19
Multimedia supporting files ............... 53
SED ........ See Survey of Earned Doctorates
Sequence of Document Elements ........ See Order of Document Elements
Single-space ........ See Spacing
Spacing .............................................. 44
Block quotes .............................................. 45
Footnotes .............................................. 49
Paragraph .............................................. 44
Reference list .............................................. 40
Tables .............................................. 50
Styles
Applying in template ...................................... 55
Formatting in attached template ........ 57
Modifying .............................................. 65
Required when attaching the template .............................................. 57–58
Required when working in template .......... 55
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using styles to generate an automatic table of contents</td>
<td>65</td>
</tr>
<tr>
<td>Survey of Earned Doctorates</td>
<td>20</td>
</tr>
<tr>
<td>Symbols</td>
<td></td>
</tr>
<tr>
<td>List of</td>
<td>56, 61</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>39</td>
</tr>
<tr>
<td>Example</td>
<td>79</td>
</tr>
<tr>
<td>Generate automatically</td>
<td>64–66</td>
</tr>
<tr>
<td>Inserting automatically with attached template</td>
<td>60</td>
</tr>
<tr>
<td>Manual dot leaders</td>
<td>64</td>
</tr>
<tr>
<td>Replacing in template</td>
<td>56</td>
</tr>
<tr>
<td>Style</td>
<td>57</td>
</tr>
<tr>
<td>Tables</td>
<td>50</td>
</tr>
<tr>
<td>Captions</td>
<td></td>
</tr>
<tr>
<td>List of</td>
<td></td>
</tr>
<tr>
<td>Template</td>
<td>54</td>
</tr>
<tr>
<td>Attaching</td>
<td>58</td>
</tr>
<tr>
<td>Downloading</td>
<td>55</td>
</tr>
<tr>
<td>Margins</td>
<td>59</td>
</tr>
<tr>
<td>Styles</td>
<td>55, 57</td>
</tr>
<tr>
<td>Table of contents and list of figures/tables</td>
<td>56, 60</td>
</tr>
<tr>
<td>Using with a preexisting document</td>
<td>57</td>
</tr>
<tr>
<td>Writing a document within</td>
<td>54</td>
</tr>
<tr>
<td>Thesis</td>
<td></td>
</tr>
<tr>
<td>Format review</td>
<td>6–7</td>
</tr>
<tr>
<td>Thesis Coordinator</td>
<td>8</td>
</tr>
<tr>
<td>Address</td>
<td>90</td>
</tr>
<tr>
<td>Contact information</td>
<td>iii</td>
</tr>
<tr>
<td>Title Page</td>
<td>29–33</td>
</tr>
<tr>
<td>Example</td>
<td>71</td>
</tr>
<tr>
<td>Style</td>
<td>57</td>
</tr>
<tr>
<td>Video Files</td>
<td></td>
</tr>
<tr>
<td>Works Cited</td>
<td></td>
</tr>
<tr>
<td>Writing Center</td>
<td>25</td>
</tr>
</tbody>
</table>